


 EasyPhoto

This Help topic contains the macro that opens the Contents topic in a secondary window when the user 
double-clicks the filename in the File Manager or the Contents button in any other Help topic. When 
started from EasyPhoto, the Help call bypasses this topic and goes directly to the Contents topic.    This 
avoids the momentary "flash" of the main Help window.    However, in this case, the Help window doesn't 
stay on top. (Apparently, it's necessary to go to a MAIN Help window first before the HelpOnTop can take 
effect.)



Searching for Help

You can look up a Help topic in an alphabetized list, just like you use an index in a book. Here's how you 
do it:

Click the Search button at the top of this Help window.
In the Search dialog box, type the key word you're looking for, or select the word from the 

alphabetized list.
Click Show Topics.
Select the Help topic you want to see, and click Go To.

Tip If you would prefer to look at Help topics organized by subject area, like the contents of a book, 
click the Contents button in this Help window. Then click the "Using EasyPhoto" button in the 
Contents window.



Using EasyPhoto

You can get step-by-step Help for working with EasyPhoto. Just click a topic.

    Working with the Photo Gallery

    Using photos in your word processor

    Making changes with the Photo Workshop

    Printing photos

    Creating slide shows, screen savers, and wallpaper

Tip You can also look for a topic by keyword. Click Search at the top of this window.



Using EasyPhoto

You use Photo Galleries to view and organize your photos. Click the topic you want to see.

    Working with the Photo Gallery
Creating a Photo Gallery
Adding a photo to a Photo Gallery
Organizing photos in a Photo Gallery
Saving a Photo Gallery
Looking at photos in a Photo Gallery

    Using photos in your word processor

    Making changes with the Photo Workshop

    Printing photos

    Creating slide shows, screen savers, and wallpaper



Using EasyPhoto

You create a Photo Gallery from one or more photos. How you create the Gallery depends on where you 
have your photos. Click the topic you want to see.

    Working with the Photo Gallery
Creating a Photo Gallery

With your Photo Reader
From photos on a CD
From photos stored in a directory

    Using photos in your word processor

    Making changes with the Photo Workshop

    Printing photos

    Creating slide shows, screen savers, and wallpaper



Using EasyPhoto

Once you create a Gallery, it's easy to add photos. Click the topic you want to see.

    Working with the Photo Gallery
Adding a photo to a Photo Gallery

Adding a photo with the Photo Reader
Adding a photo from a CD
Adding a photo stored in a directory
Using a photo from another Photo Gallery
Adding part of a photo to a Photo Gallery

    Using photos in your word processor

    Making changes with the Photo Workshop

    Printing photos

    Creating slide shows, screen savers, and wallpaper



Using EasyPhoto

Once you put photos in a Gallery, you can rearrange them easily. Click the topic you want to see.

    Working with the Photo Gallery
Organizing photos in a Photo Gallery

Moving photos in a Photo Gallery
Removing a photo from a Photo Gallery
Moving a photo to another Photo Gallery

    Using photos in your word processor

    Making changes with the Photo Workshop

    Printing photos

    Creating slide shows, screen savers, and wallpaper



Using EasyPhoto

To help organize your photos, you can add descriptive titles and captions. You can also find a photo 
quickly. Click the topic you want to see.

    Working with the Photo Gallery
Looking at photos in a Photo Gallery

Opening a Photo Gallery
Finding a photo
Changing the photo's title
Adding a caption to a photo
Getting information about a photo

    Using photos in your word processor

    Making changes with the Photo Workshop

    Printing photos

    Creating slide shows, screen savers, and wallpaper



Using EasyPhoto

Once you bring your photos into EasyPhoto, you can easily put them into any word-processing document.
Click the topic you want to see.

    Working with the Photo Gallery

    Using photos in your word processor
Inserting a photo into a word-processing document
Inserting part of a photo into a word-processing document
Making changes to a photo after it's in a document

    Making changes with the Photo Workshop

    Printing photos

    Creating slide shows, screen savers, and wallpaper



Using EasyPhoto

The EasyPhoto Workshop gives you the tools to do the things you always wanted to do with your photos, 
such as adjust the exposure (brightness) or make enlargements (resize). Click the topic you want to see.

    Working with the Photo Gallery

    Using photos in your word processor

    Making changes with the Photo Workshop
Resizing a photo
Cropping a photo
Rotating a photo
Changing the brightness and contrast of a photo
Adjusting the colors of a photo
Removing a scratch from a photo
Fixing a "red-eye" problem
Flipping a photo
Looking at a photo in more detail (zoom)
Making changes to part of a photo
Undoing a change you made to a photo
Saving the changes you made to a photo

    Printing photos

    Creating slide shows, screen savers, and wallpaper



Using EasyPhoto

Once you have your photos in your computer, you might as well have some fun with them. You can show 
a bunch of photos as a slide show on your computer screen. You can also use some photos as a screen 
saver. Or, you can use a single photo as the background wallpaper on your Windows desktop. Click the 
topic you want to see.

    Working with the Photo Gallery

    Using photos in your word processor

    Making changes with the Photo Workshop

    Printing photos

    Creating slide shows, screen savers, and wallpaper
Showing photos in a slide show
Sharing a slide show with someone else
Using photos as a screen saver
Making Windows wallpaper from a photo



Help Menu



Help Topics Command (Help Menu)

You choose this command to go to the Help Contents, where you can get information about using 
EasyPhoto, searching for a Help topic, or learning how to use Help.

Tip For general information about the EasyPhoto window you are using, close this Help window and 
click this button on the toolbar:



EasyPhoto Tips Command (Help Menu)

You choose this command to see a helpful tip about EasyPhoto.

The tips give you hints about using EasyPhoto, about using your photos creatively, and about how to 
dress for success.

Tip Here's an easy way to see one of the tips: click the EasyPhoto logo near the top of any Gallery.



EasyPhoto Tip of the Day

This dialog shows you a new tip about using EasyPhoto every time you click the EasyPhoto logo near the
top of any Gallery.

If you'd like to see all the tips at one sitting, just keep clicking Next Tip in this dialog box.

Note If you'd like to share a great tip about a way you work with EasyPhoto, give us a call at 1-800-275-
5734. Let's hear from you.

Note If you don't quite understand the tip or want more details on the feature it describes, click Contents
at the top of this Help window. Then, click the Search for Help on button, and use the index to find
the Help topic related to the subject of the tip.



About EasyPhoto Command (Help Menu)

You use this command to see trademark and copyright information and other boring stuff.



Miscellaneous Help Topics



Getting Customer Service

If you have a problem using EasyPhoto, and you can't find the solution in the online Help:

Jot down the steps you did before you ran into difficulties.

Make a note of any messages you saw on the screen.

Call Storm Customer Service. Have EasyPhoto running on your computer when you call.
Customer Service Phone Number

1-415-969-9555
Other Ways to Get Customer Service
You can also send us an e-mail, and we'll get back to you right away. Here are our e-mail addresses:

Internet: support@stormsoft.com

America Online: STORMSOFT

CompuServe: 73060,3227

Prodigy: UEJR16A
If you have a web browser and access to the Internet, take a look at the Storm Home Page at:

http://www.stormsoft.com/storm/

Tip You don't have to wait until you have a problem before you call or write us. Feel free to call and talk
with us about EasyPhoto or the meaning of life.



Searching for Help

You can look up a Help topic in an alphabetized list, much like you use an index in a book. Here's how 
you do it:

Click the Search button at the top of this Help window.

In the Search dialog box, type the key word you're looking for, or select the word from the 
alphabetized list.

Click Show Topics.

Select the Help topic you want to see, and click Go To.

Tip If you would prefer to look at Help topics organized by subject area, like the contents of a book, 
click the Contents button in this Help window. Then click the "Using EasyPhoto" button in the 
Contents window.



 EasyPhoto Getting Started

This Help topic contains the macro that opens the Walk-Through in a secondary window when the 
customer clicks on one of the Walk-Through keywords in the Help Search dialog. The customer never 
sees this topic.



Glossary

This Help topic contains the macro that opens the Glossary in a secondary window when the customer 
clicks on one of the Glossary keywords in the Help Search dialog. Without this topic, the Glossary opens 
in a standard Help window. The customer never sees this topic.



Getting Help

Whatever you're doing in EasyPhoto, Help is just a mouse click away.

If you need Help on: Do this:

The Gallery or Photo

    Workshop window In that window, click:    

A menu command Select the command, and press F1.
A dialog box Click the Help button in the dialog box
Step-by-step guidance
    on using EasyPhoto Click the Contents button in this Help window. Then click the "Using EasyPhoto"

button in the Contents window. Or, while working in EasyPhoto, choose Help 
Topics from the Help menu.

An unfamiliar word Click the Glossary button in this window or in any other Help window. (You can 
also click on an underlined word in a Help topic to see a definition.)

Tip To look up a Help topic in an alphabetized list, much like you use an index in a book, click the 
Search button in this window or in any other Help window.

Tip You can easily print any individual Help topic. While looking at the topic, choose Print Topic from 
the File menu in the Help window.

Tip EasyPhoto Help is set to stay on top of other windows, to make it easy for you to read the Help and
work in the program at the same time. If you want to let the Help window take its place behind other
windows, choose Always on Top from the Help menu.

Tip To find out more than you ever wanted to know about standard Windows Help features, press F1 
now or in any other Help window.



The Gallery

You use the Photo Gallery to view and organize your photos. For example, you can create a Gallery for 
photos from your rafting trip on the Rogue River and another Gallery for pictures of your family over the 
holidays.

You can catalog photos stored on your hard disk, on a diskette, or on a CD. Or, you can use your Photo 
Reader to add electronic copies of your photos to a Gallery.

The Gallery shows a small representation of each of the photos. A colored border highlights the selected 
photo.

The small representation 
of the photo lets you 
identify the photo without 
opening the file.

You can give the photo a 
title and a caption. Click 
the title bar to see the title 
card with more information
about the photo.

After you put a photo in a Gallery, you can drag and drop it into a word-processing document. You can 
also double-click the photo in the Gallery to work on it in the Photo Workshop.

Each button on the toolbar is a shortcut to get the job done. When you pause the cursor over the button, a
yellow label tells you the name of the button.

Show me how to...
Create a Photo Gallery
Add a photo to a Photo Gallery
Open a Photo Gallery
Organize photos in the Photo Gallery
Use photos as a screen saver



Show photos in a slide show
Find a photo
Get information about a photo

Add a caption to a photo

Change the photo's title

Make changes to a photo

Save a Photo Gallery



EasyPhoto Tips

You click this button to see a helpful tip about EasyPhoto.

The tips give you hints about using EasyPhoto, about using your photos creatively, and about how to 
dress for success.

Note

If you want more Help on the Gallery, click    

    in the Gallery window.



File Menu



Create or Open Photo Gallery Command (File Menu)

You click this button or choose this command to create a new Photo Gallery or open an existing one.

EasyPhoto shows you a dialog box where you can open a Gallery you worked with recently or create a 
new one.

Show me how to...

Create a Photo Gallery

Open a Photo Gallery



Create or Open Photo Gallery Dialog Box

You use this dialog box to create a new Photo Gallery or open an existing one.

Dialog box options
Existing Galleries The list shows you all of the Galleries you've created, starting with the Galleries 

you used most recently.

Create New Gallery Click to create a new, empty Photo Gallery. Later you can add the photos you 
want to have in the Gallery.

Open Selected Gallery Click to open the Gallery selected in the list. You can also double-click a Gallery 
name to open it.

Note EasyPhoto comes with more than 100 photos organized into a sample Gallery to get you started. 
You can use this Gallery, which also shows up in the list, just like any Gallery you create.

Show me how to...

Create a Photo Gallery

Open a Photo Gallery

Use photos as a screen saver



EasyPhoto Needs to Move Gallery

You asked to open a Gallery that is stored in a place where EasyPhoto can't work. Before EasyPhoto can 
open this Gallery, it needs to move it to the directory where all the other Galleries are stored.

Click OK to let EasyPhoto move the Gallery and open it for you. As an added benefit, the next time you 
start EasyPhoto, you'll find this Gallery in the Gallery list. You'll be able to open it from there.

Click Cancel if you don't want to open the Gallery now.



Save Gallery Command (File Menu)

You choose this command to save the current Photo Gallery.

If you've not saved this Gallery before, EasyPhoto asks you for a name. That's reasonable, isn't it?

Show me how to...

Save a Photo Gallery



Name Photo Gallery Dialog Box

You use this dialog box to name the Photo Gallery you've created.

Type any name you want, up to 32 characters, in the box.



Already a Gallery With That Name

Uh-oh. You typed a Gallery name that you've already used for another Photo Gallery.

Click OK and then type another name. Be creative.

You might also want to open that other Gallery (now that you know there IS another Gallery) and see 
what's going on.



Use Gallery as Screen Saver Command (File Menu)

You choose this command to make a Windows screen saver from the photos in this Gallery.

From then on, whenever your computer remains inactive for 5 minutes (or for whatever time you have set 
in the Windows Control Panel), the photos in this Gallery appear, one by one, like a slide show on your 
screen.

Note To change the screen saver, you can add photos to or remove photos from this Gallery. Or, you can
make another Gallery the screen saver by choosing this command from that Gallery. You remove a 
screen saver by using the Desktop controls in the Windows Control Panel.

Note The screen saver works even if EasyPhoto is not open at the time.

Note If you installed a screen saver program from another company, you might need to turn it off before 
you can see your EasyPhoto screen saver. Try the steps above first. If you don't see your photos, 
then try turning off the other screen saver.

Tip Forget which Gallery you're using as a screen saver? Choose Create or Open Photo Gallery from
the File menu, and look in the list of existing Galleries. The note, "screen saver", identifies the 
Gallery you're using as the screen saver.

Show me how to...

Use photos as a screen saver

Turn off a screen saver

Open a Photo Gallery



Display Gallery as Slide Show Command (File Menu)

You choose this command to show the photos in this Gallery as a slide show on your computer screen. 
EasyPhoto shows the photos one by one, each one for about 10 seconds.

During the slide show, EasyPhoto gives you a small set of controls, like those on a VCR, which you can 
use to control the show manually if you want.

After the show, EasyPhoto returns to the Gallery.

Tip During a slide show, EasyPhoto also displays a caption for each photo. Add your own captions to 
photos before you look at the slide show. Otherwise, EasyPhoto just uses the photo's title or 
filename. You can also turn off the captions with the slide show controls.

Show me how to...

Show photos in a slide show

Share a slide show with someone else

Add a caption to a photo

Change the photo's title



Save Slide Show to Diskette Command (File Menu)

You choose this command to make a slide show from the photos in this Gallery and save it to a diskette, 
for example, to give to someone else.

EasyPhoto creates the slide show and puts it on the diskette in drive A.

Tip You can give a slide show of your photos to a friend, even if they don't have EasyPhoto on their 
computer. When you create the slide show, EasyPhoto automatically includes a copy of the 
EasyPhoto Slide Show viewer, which lets anyone with Windows play the slide show.

Tip You can fit a slide show with up to 24 photos on a single diskette. If you want to show more photos,
create another Gallery and make a second slide show.

Tip To see how the slide show will look before you give it to someone else, choose Display Gallery as 
Slide Show from the File menu.

Tip Before you make a slide show, add captions your photos. EasyPhoto shows the captions along 
with the photos.

Show me how to...

Share a slide show with someone else

Show photos in a slide show

Add a caption to a photo

Create a Photo Gallery

Add a photo to a Photo Gallery



Add Photos to Gallery Command (File Menu)

You click this button or choose this command to add one or more photos to a Photo Gallery you created.

EasyPhoto shows you a dialog box where you tell EasyPhoto where to get the photos.

Show me how to...

Add a photo to a Photo Gallery

Create a Photo Gallery



Add Photos to Gallery Dialog Box

You use this dialog box to add photos to a Photo Gallery.

Click one of the three buttons to tell EasyPhoto where to find the photos you want to add. You can get 
photos by using your Photo Reader or from photos in a digital camera, from a CD, or from a directory on 
your hard disk (or diskette).

Once you click a button, EasyPhoto shows you a dialog box where you can add photos to the Gallery.

Tip If you don't have a Photo Reader but want to find out how to get one, click here.

Show me how to...

Add a photo to a Photo Gallery



Add Photos from Directory Dialog Box

You use this dialog box to put photos stored in a directory on your hard disk (or diskette) into a Photo 
Gallery.

Dialog box options
Directories Select (double-click) the directory that has the photos you want to add to the Gallery. If 

the photos are in a directory on another drive, use the drives list to select the drive.

List of photos Select the photos you want to add to the Gallery. The list shows all of the photos (in 
formats that EasyPhoto understands) in the directory you selected. To select more than
one photo, hold down the Ctrl key while you click the photo filenames.

Always Preview Select the check box to see what each photo looks like as you select it. To preview just 
the selected photo, click inside the preview frame.

Add Click to add the selected photos to the Gallery and close this dialog box.

Add All Click to add all of the photos shown in the list, whether or not they are selected, to the 
Gallery and close this dialog box.

Show me how to...

Create a Photo Gallery

Add a photo to a Photo Gallery



Insert Photo from File Dialog Box

You use this dialog box to add a photo to the page. Once you've added the photo, you can double-click it 
at any time to open EasyPhoto and make changes to the photo, without leaving the other program.

Dialog box options
Directories Select (double-click) the directory that has the photos you want to add. If the photos 

are in a directory on another drive, use the drives list to select the drive.

List of photos Select the photo you want to add. The list shows all of the photos (in formats that 
EasyPhoto understands) in the directory you selected.

Always Preview Select the check box to see what each photo looks like as you select it. To preview just 
the selected photo, click inside the preview frame.

Insert Photo Click to add the selected photo to the page and close this dialog box.

Show me how to...

Position photos in a document



Add Photos from Photo CD Dialog Box

You use this dialog box to put photos stored on a Kodak Photo CD into a Photo Gallery.

Dialog box options
List of photos Select the photos you want to add to the Gallery. The list shows all of the photos on the

CD. To select more than one photo, hold down the Ctrl key while you click on the photo
numbers.

Photo preview Shows you what the selected photo looks like.

Add Click to add the selected photos to the Gallery and close this dialog box.

Add All Click to add all of the photos shown in the list, whether or not they are selected, to the 
Gallery and close this dialog box.

Show me how to...

Create a Photo Gallery

Add a photo to a Photo Gallery



Add Photos from CD Dialog Box

You use this dialog box to put photos stored on a CD into a Photo Gallery.

Dialog box options
Directories Select (double-click) the directory that has the photos you want to add to the Gallery.

List of photos Select the photos you want to add to the Gallery. The list shows all of the photos in the 
directory you selected. To select more than one photo, hold down the Ctrl key while you
click on the photo filenames.

Always Preview Select the check box to see what each photo looks like as you select it. To preview just 
the selected photo, click inside the preview frame.

Add Click to add the selected photos to the Gallery and close this dialog box.

Add All Click to add all of the photos shown in the list, whether or not they are selected, to the 
Gallery and close this dialog box.

Show me how to...

Create a Photo Gallery

Add a photo to a Photo Gallery



Name CD Dialog Box

EasyPhoto keeps track of your photos stored on CDs by the name you give the CD.

Type a name for this CD. It can be anything you want, up to a limit of 32 characters. Go wild.



Photo Reader Dialog Box

You use this dialog box to make an electronic copy of a photo with your Photo Reader and then put the 
photo into a Photo Gallery.

Dialog box options
Preview area This box shows you how to put the photo into the Photo Reader and tells you when the 

Photo Reader has warmed up and is ready to copy. After you start copying, this box 
shows the progress as the Photo Reader copies the photo.

Speed indicator (Only available while you're using the Photo Reader manually) When using the Photo 
Reader by hand, move the Photo Reader slowly to keep the indicator in the green.

Add to Gallery Click this button, after the Photo Reader stops copying, to put the photo into the current
Gallery.

Show me how to...

Create a Photo Gallery

Add a photo with the Photo Reader

Use the Photo Reader manually



Name Photo Dialog Box

You use this dialog box to give a name to the photo you just copied with the Photo Reader.

Type any name you want, up to 32 characters, in the box.

The name you type becomes the title for the photo, which shows on the title bar beneath the photo in the 
Gallery.

Note EasyPhoto automatically creates a standard eight-character filename from the name you type, so 
that Windows can keep track of it, and stores the photo in the \EZPHOTO\PHOTO directory.



Name Photos Dialog Box

You use this dialog box to name the photos you're adding to the Photo Gallery.

Type any name you want, up to 30 characters, in the box. EasyPhoto uses this name as a prefix and adds
a sequential number on the end to distinguish each photo.

The names become the titles for the photos, which show on the title bar beneath each photo in the 
Gallery. You can change these titles later.

Note EasyPhoto automatically creates standard eight-character filenames from the name you type, so 
that Windows can keep track of the photos, and stores them in the \EZPHOTO\PHOTO directory.

Show me how to...

Change the photo's title



Scanners and Cameras

You use this dialog box to select a scanner, such as the EasyPhoto Reader, or a digital camera to use to 
put photos into a Photo Gallery.

The list shows the scanners and digital cameras connected to your computer. Click the one you want to 
use, and then click OK.



Delete Photo from Gallery Command (File Menu)

You choose this command to remove the selected photo from the Gallery. The selected photo has a 
colored (highlighted) border and a highlighted title.

If you want to remove a photo and put it on the Windows Clipboard, to use it somewhere else, choose 
Cut from the Edit menu.

Note EasyPhoto removes the photo only from the current Gallery. You can still keep the photo in other 
Galleries.

Note For photos you have stored on your hard disk in the EasyPhoto PHOTO directory, if the photo is 
not in any other Gallery, EasyPhoto asks whether you want to delete it from the disk. You must 
keep each photo in at least one Gallery. This is EasyPhoto's way of keeping unused photos from 
cluttering up your hard disk.

Show me how to...

Remove a photo from a Photo Gallery

Move a photo to another Photo Gallery



Delete Photo from Disk

You have asked to remove a photo from this Gallery, and it's not in any other Gallery. You can do that, but
EasyPhoto will need to delete the photo from your hard disk as well. This is EasyPhoto's way of keeping 
unused photos from cluttering up your disk.

Click OK to remove the photo from the Gallery and delete it from the disk as well.

Click Cancel to keep the photo in the Gallery.

Note If you want to keep the photo but delete the Gallery, first move this photo to another Gallery.

Show me how to...

Move a photo to another Photo Gallery



Rename Gallery Command (File Menu)

You choose this command to give a different name to the current Photo Gallery.

EasyPhoto shows you a dialog box where you can type the new name.



Rename Photo Gallery Dialog Box

You use this dialog box to give the current Photo Gallery a new name.

Type any name you want, up to 32 characters, in the box.



Delete Gallery Command (File Menu)

You choose this command to get rid of a Photo Gallery.

EasyPhoto shows you a dialog box where you select the Gallery you want to delete.

Note When you delete a Gallery, you don't delete or damage any of the photos that you had cataloged in
that Gallery. It's sort of like if you were to take all the pictures out of your baby album and then burn
the album. You still have the pictures. The album is history.

Note If the Gallery you ask to delete has photos that you added with your Photo Reader and the photos 
are not in any other Gallery, EasyPhoto asks whether you want to delete those photos from your 
hard disk. You must keep each photo in at least one Gallery. This is EasyPhoto's way of keeping 
unused photos from cluttering up your disk.



Delete Photo Gallery Dialog Box

You use this dialog box to get rid of a Photo Gallery.

Select the Gallery you want to delete in the list of Galleries. Then click Delete.

Note If the Gallery you ask to delete has photos that you added with your Photo Reader and the photos 
are not in any other Gallery, EasyPhoto asks whether you want to delete those photos from your 
hard disk. You must keep each photo in at least one Gallery. This is EasyPhoto's way of keeping 
unused photos from cluttering up your disk.



Delete an Open Gallery?

You've asked to delete a Photo Gallery that you have open.

It's OK to do that. EasyPhoto is just checking to make sure you don't delete a Gallery that you're still 
working with.

Click OK to delete the open Gallery. Click Cancel to return to the Delete Photo Gallery dialog box and 
choose another Gallery to delete.



Show at Startup Command (File Menu)

A check mark next to this command shows that EasyPhoto displays this Photo Gallery every time you 
start the program. That's the way EasyPhoto starts out with each Gallery.

To turn off Show at Startup, choose this command. To turn it on again, choose it again.

Show me how to...

Show a Gallery when EasyPhoto starts



Always on Top Command (File Menu)

If this button is selected (pressed down) or a check mark shows next to this command, the Photo Gallery 
stays on top (in front of) all other windows. That's the way EasyPhoto starts out with each Gallery you 
create.

To turn off Always on Top, click the button (the button comes back up) or choose this command. To turn 
it on again, click it or choose it again.

Tip Keep the Gallery "always on top" when you're putting photos in a word-processing document. Put 
the Gallery up in the corner while you work in the word processor. When you're ready to insert a 
photo, just drag it from the Gallery.

Show me how to...

Insert a photo into a word-processing document



Close/Exit Command (File Menu)

You use this command to close the current Photo Gallery.

If you've made changes to the Gallery, EasyPhoto asks you whether you want to save those changes 
before you close it.

After you've closed all but the last Gallery, this command changes from Close to Exit, which both closes 
the Gallery and exits EasyPhoto.



Edit Menu



Undo/Redo Commands (Edit Menu)

You use the Undo command to reverse the last change you made. The command tells you exactly what 
you are undoing, such as Undo Move Photo.

Once you undo a change, the command name changes to Redo. Choose Redo to restore the change, 
essentially undoing the undo. This lets you change your mind, if that's what you need to do.

If you haven't made any changes, the command name says Can't Undo.



Cut Command (Edit Menu)

You choose this command to remove the selected photo (the one with a colored border) from the Gallery 
and place it on the Clipboard. You can then move (paste) the photo to another Gallery or to any other 
Windows application that can accept photos.

The cut photo stays on the Clipboard until you cut or copy something else. There's only room for one 
selection on the Windows Clipboard.

If you want to remove a photo but not put it on the Clipboard, choose Delete Photo from Gallery from 
the File menu.

Show me how to...

Move a photo to another Photo Gallery



Copy Command (Edit Menu)

You choose this command to make a copy of the selected photo (the one with a colored border) in the 
Gallery and place it on the Clipboard. You can then paste the photo and its information (title and caption) 
into another Gallery or to any other Windows application that can accept photos. This is one way to add 
photos to another Gallery.

The copied photo stays on the Clipboard until you cut or copy something else. There's only room for one 
selection on the Windows Clipboard.

Tip Although you can copy and paste photos in the Gallery, drag and drop is a whole lot easier. The 
"Show me how" below gives the steps.

Show me how to...

Use a photo from another Photo Gallery



Paste Command (Edit Menu)

You choose this command to move a copy of the Clipboard contents to the current Gallery.

The Clipboard contains whatever you last cut or copied. This might be a photo image from another 
Gallery, a photo file, or even some text from a word-processing document. But, in the Photo Gallery, you 
can only paste photo files or Gallery images of photos into the current Gallery.

Note This command is available only if you've cut or copied a photo or part of a photo.

Note If you paste a photo file, such as a BMP file, into the Gallery, EasyPhoto first asks you to save the 
photo with a unique name. EasyPhoto doesn't save the actual photo file in the Gallery, only a small 
representation of the photo and information about where it's saved.

Show me how to...
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Find Photos Command (Edit Menu)

You choose this command to look for a photo in the current Photo Gallery or in all of your Galleries.

EasyPhoto shows you a dialog box where you tell EasyPhoto what to look for.

Show me how to...
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Find Photos Dialog Box

You use the By Words tab of this dialog box to look for photos based on certain words contained in the 
photo title or caption.

Dialog box options
Search words In the box, type the words that you think are contained in the title or caption of the 

photo you're looking for. You can type a word, word fragment, or a phrase. EasyPhoto 
treats multiple words as a phrase, rather than searching for any of the words 
individually. Capitalization doesn't matter.

Where to look Select one of the two radio buttons to have EasyPhoto look in just the current Photo 
Gallery or in all of your Galleries.

Find After you tell EasyPhoto what to look for and where to look, click this button to start the 
search.

Note EasyPhoto copies all photos that contain the words you typed into a new Gallery.

Tip You can also search for photos by example, meaning that you can find photos similar in 
appearance to the selected photo. Click the By Example tab in this dialog box. For Help with 
options on that tab, click Help there.

Show me how to...
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Find Photos Dialog Box

You use the By Example tab of this dialog box to look for photos that appear similar to the selected photo
in the Photo Gallery.

Dialog box options
Example photo Shows the photo that EasyPhoto will use 

as a guide photo when looking for similar 
photos. EasyPhoto looks for photos with 
similar colors.

Use these buttons to select another photo
in the Gallery without going back to the 
Gallery.

Where to look Select one of the two radio buttons to 
have EasyPhoto look in just the current 
Photo Gallery or in all of your Galleries.

Find After you tell EasyPhoto what to look for 
and where to look, click this button to start
the search.

Note EasyPhoto puts all photos it thinks are similar to your selected guide photo into a new Gallery. The 
most similar photo comes first.

Tip You can also search for photos that contain certain words in the title or caption. Click the By Words
tab in this dialog box. For Help with options on that tab, click Help there.

Show me how to...
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Edit Photo Information Command (Edit Menu)

You click this button or choose this command to change the photo title or to add or change the photo 
caption.

The photo title shows on the title bar beneath each photo in the Gallery. If you don't change it, the title is 
the photo's filename. You see the caption on the title card, which shows when you click the title bar.

You can add a caption.

The title is by default the photo's 
filename, but you can change it.

Show me how to...
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Edit Photo Information Dialog Box

You use this dialog box to change the photo title or to add or change the photo caption.

Dialog box options
Title In the box, type a title of up to 32 characters for the photo. About 12 characters of the 

photo title show on the title bar beneath each photo in the Gallery. If you don't change it, 
the title is the photo's filename.

Caption In the box, type a caption of up to 256 characters for the photo. To start a new paragraph,
press Ctrl+Enter.

Previous Click to edit the photo information for the previous photo in the Gallery.

Next Click to edit the photo information for the next photo in the Gallery.

Note The photo information also includes the photo's filename, file size, and where the photo file is 
stored (hard disk, diskette, or CD), but you can't edit this information.

Note Long captions might not fit on the title card. If you don't see the whole caption you typed, you can 
always come back to this dialog box to read it.

Show me how to...
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Open Photo in Workshop Command (Edit Menu)

You choose this command to open the selected photo in the Photo Workshop, where you can make 
changes to the photo. For example, you can tone down some weird colors or make the photo larger or 
smaller.

Tip You can also double-click the photo image in the Gallery to open it in the Photo Workshop.

Show me how to...
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Insert CD Dialog Box

The photo you asked to open in the Photo Workshop or to put in a document is stored on a CD. This 
dialog box tells you the name of the CD. Before EasyPhoto can show you the photo, you need to put that 
CD in your CD-ROM drive. After you do that, click OK.

If you've already put the CD in the drive, check to make sure you've got the right CD and that the drive is 
functioning properly.



Insert Diskette Dialog Box

The photo you asked to open in the Photo Workshop or to put in a document is stored on a diskette. This 
dialog box tells you the photo's filename. Before EasyPhoto can show you the photo, you need to put the 
diskette with that photo in your floppy drive.

If you've already put the diskette in the drive, check that it's the right diskette (they all look alike, don't 
they?) and that the drive door is closed.



Can't Find Photo File

The photo you asked to open in the Photo Workshop or to put in a document was stored on your hard 
disk. EasyPhoto looked for it in the place it used to be but couldn't find it there.

Either you moved or deleted the photo.

If you moved it, click Find File. EasyPhoto shows you the Find File dialog box, where you can browse 
through your directories to locate the file. When you find the file, select it and click OK. EasyPhoto will 
automatically remember where it is from now on.

If you deleted the file but have a backup copy, click Cancel. Then copy the photo back to its old directory 
and you're in business.

If you deleted the file and don't have a backup copy, you're out of luck. That's a case where EasyPhoto 
can't help you. Sorry.



Find File Dialog Box

You use this dialog box to tell EasyPhoto where to find a photo that you moved.

Dialog box options
Directories Select (double-click) the directory that now has the photo EasyPhoto is looking for. If 

the photo is in a directory on another drive, use the drives list to select the drive.

List of photos Select the photo EasyPhoto is looking for. The list shows all of the photos (in formats 
that EasyPhoto understands) in the directory you selected. After you select the photo, 
click OK.

Always Preview Select the check box to see what each photo looks like as you select it. To preview just 
the selected photo, click inside the preview frame.

Note Once you put the photo back in the Gallery, EasyPhoto will automatically remember where its file is
stored from now on. You don't have to go through this every time you want to use the photo.



Creating a Photo Gallery

You create a Gallery to view and organize your photos. You can create a Gallery:

With your Photo Reader

From photos on a CD

From photos stored in a directory on your hard disk (or diskette)
You can also create an empty Gallery and fill it with photos later.
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Creating a Photo Gallery from Photos Stored in a Directory

From any Photo Gallery, click    

Click Create New Gallery.

Click    

In the Add Photos to Gallery dialog box, click the Hard Disk or Diskette button.
In the Add Photos from Directory dialog box, select (double-click) the directory that has the 

photos you want to put in the new Gallery.
If the directory is on another disk drive, first select that drive and then select the directory.

Select the photos you want to put in the new Gallery.
Click the photo's filename to select it. To select more than one photo, hold down the Ctrl key while 
you click the filenames.

Click Add.
EasyPhoto adds the photos you selected to the new Gallery and closes the dialog box.

Tip To see what each photo looks like as you select its filename, select the Always Preview check 
box. To preview just a single photo, select its filename and then click inside the preview frame.

Tip To add all photos in the list to the Gallery, after step 5, click Add All. You don't have to select the 
photos first.



Creating a Photo Gallery from Photos on a CD

You can create a new Gallery with your own photos you had put on a Kodak Photo CD or with 
professional photos from a CD you bought.

To create a Gallery from a CD:

Insert the CD into your computer's CD-ROM drive.

From any Photo Gallery, click    

Click Create New Gallery.

Click    

In the Add Photos to Gallery dialog box, click the CD button.
In the Add Photos from CD dialog box, either click Add All to add all photos in the list of photos to

the new Gallery, or, to add just some of the photos, select the ones you want and click Add.
To select a photo, if you have a Photo CD (with a list of photo numbers), you simply click the photo's 
number. The photo numbers in the list match the numbers on the Photo CD jewel box.

If you have another type of CD (with lists of both directories and photo filenames), you need to first 
select (double-click) the directory that has the photos you want to put in the new Gallery. Then click 
the photo's filename to select it.

To select more than one photo, hold down the Ctrl key while you click the photo numbers or 
filenames.

EasyPhoto adds the photos you selected to the new Gallery and closes the dialog box.

Tip To see what each photo looks like as you select its filename, select the Always Preview check 
box. To preview just a single photo, select its number or filename and then click inside the preview 
frame.



Creating a Photo Gallery with Your Photo Reader

You use the Photo Reader to make an electronic copy of a photo to use, for example, in your word-
processing documents. As you use the Photo Reader, you can create a new Gallery to organize the 
photos you copy.

To use the Photo Reader to add photos to a new Gallery:

Connect your Photo Reader. To do this, follow the steps in the booklet, "Using Your EasyPhoto 
Reader", which came in the EasyPhoto Reader box.

Back at your computer screen, from any Photo Gallery, click    

Click Create New Gallery.

Click    

In the Add Photos to Gallery dialog box, click the Photo Reader or Camera button.
Place the photo, face up, in the Photo Reader. The left edge of the photo goes in first. When the 

warm-up message says the Photo Reader is ready, press the Start button on the top of the Photo Reader.
The photo preview box in the Photo Reader dialog box shows the progress as the Photo Reader 
copies the photo into your computer. EasyPhoto uses Storm Software's ClearScan to get the 
sharpest, brightest copies of your photos.

If you don't like the results (for example, the photo's upside-down), you can stop the Photo Reader 
by pressing the Start button again. Click Cancel, and then start over with this step.

When the Photo Reader stops, click Add to Gallery to put the photo in the new Gallery.
At the Name Photo dialog, type a name for the photo.

EasyPhoto shows you the new Gallery with the photo you just copied. You can add more photos to 
this Gallery with the Photo Reader. Check out "Other good stuff" below.

To add more photos to the Gallery, repeat steps 6-8. When you're finished, click Close.

Tip You can also use a digital camera to put photos into your computer. Follow these general steps and
any special instructions that came with your camera.

Tip If you don't have a Photo Reader but want to find out how to get one, click here.

Tip After you put the photo into your computer, you can use the Photo Workshop to make changes. For
example, you can lighten a photo that's too dark or crop a photo. 

Other good stuff...
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Making changes to a photo



Creating an Empty Photo Gallery

From any Photo Gallery, click    

Click Create New Gallery.

Tip Some people like to drag photos from the Windows File Manager to the Gallery. You can position 
the Gallery and File Manager windows side by side and drag the filename of a photo (or even 
several photos) to the Gallery.

Other good stuff...

Adding a photo to a Photo Gallery



Adding a Photo to a Photo Gallery

Once you create a Photo Gallery, you can add photos to it at any time. You can add photos:

With your Photo Reader

From a CD

Stored in a directory on your hard disk (or diskette)

From another Photo Gallery
You can also add part of a photo to a Gallery.
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Adding a Photo Stored in a Directory

In the Photo Gallery, click    

In the Add Photos to Gallery dialog box, click the Hard Disk or Diskette button.

In the Add Photos from Directory dialog box, select (double-click) the directory that has the photo 
you want to add the Gallery.

If the directory is on another disk drive, first select that drive and then select the directory.

Select the photo you want to add to the Gallery.
Click the photo's filename to select it. To select more than one photo, hold down the Ctrl key while 
you click the filenames.

Click Add.
EasyPhoto adds the photo(s) you selected to the current Gallery and closes the dialog box.

Tip To see what each photo looks like as you select its filename, select the Always Preview check 
box. To preview just a single photo, select its filename and then click inside the preview frame.

Tip To add all photos in the list to the Gallery, after step 3, click Add All. You don't have to select the 
photos first.



Adding a Photo from a CD

To any Gallery you can add your own photos you had put on a Kodak Photo CD. Or, you can add 
professional "stock" photos from a CD you bought.

To add photos from a CD:

Insert the CD into your computer's CD-ROM drive.

In the Photo Gallery, click    

In the Add Photos to Gallery dialog box, click the CD button.

In the Add Photos from CD dialog box, either click Add All to add all photos in the list of photos to
the new Gallery, or, to add just some of the photos, select the ones you want and click Add.

To select a photo, if you have a Photo CD (with a list of photo numbers), you simply click the photo's 
number. The photo numbers in the list match the numbers on the Photo CD jewel box.

If you have another type of CD (with lists of both directories and photo filenames), you need to first 
select (double-click) the directory that has the photos you want to put in the new Gallery. Then click 
the photo's filename to select it.

To select more than one photo, hold down the Ctrl key while you click the photo numbers or 
filenames.

EasyPhoto adds the photo(s) you selected to the current Gallery and closes the dialog box.

Tip To see what each photo looks like as you select its filename, select the Always Preview check 
box. To preview just a single photo, select its number or filename and then click inside the preview 
frame.



Adding a Photo with the Photo Reader

You use the Photo Reader to make an electronic copy of a photo to use, for example, in your word-
processing documents. So that you can work with the photo in your computer, you add it to a Gallery.

To use the Photo Reader to add a photo to a Gallery:

Connect your Photo Reader. To do this, follow the steps in the booklet, "Using Your EasyPhoto 
Reader", which came in the EasyPhoto Reader box.

Back at your computer screen, open the Photo Gallery where you want to add the photo.

Click    

In the Add Photos to Gallery dialog box, click the Photo Reader or Camera button.

Place the photo, face up, in the Photo Reader. The left edge of the photo goes in first. When the 
warm-up message says the Photo Reader is ready, press the Start button on the top of the Photo Reader.

The photo preview box in the Photo Reader dialog box shows the progress as the Photo Reader 
copies the photo into your computer. EasyPhoto uses Storm Software's ClearScan to get the 
sharpest, brightest copies of your photos.

If you don't like the results (for example, the photo's upside-down), you can stop the Photo Reader 
by pressing the Start button again. Click Cancel, and then start over with this step.

When the Photo Reader stops, click Add to Gallery to put the photo in the current Gallery.

At the Name Photo dialog, type a name for the photo.
To add more photos to the Gallery, repeat steps 5-7. When you're finished, click Close.

Tip You can also use a digital camera to put photos into your computer. Follow these general steps and
any special instructions that came with your camera.

Tip If you don't have a Photo Reader but want to find out how to get one, click here.

Tip After you put the photo into your computer, you can use the Photo Workshop to make changes. For
example, you can lighten a photo that's too dark or crop a photo. 

Other good stuff...
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Using a Photo from Another Photo Gallery 

You can catalog a photo in more than one Gallery. For example, you might want to keep that Patagonian 
train picture in both your "trains" Gallery and your "vacation '95" Gallery. You have just the one photo file, 
but each Gallery contains a reference to it.

Once you add the photo to one Gallery, you can easily copy it to another.

To copy a photo from one Gallery to another:

Arrange the two Gallery windows so that they are side by side on the screen.

Select the photo you want to copy, and drag it to the other Gallery.
EasyPhoto copies the small representation of the photo as well as the title and caption.

Note You can also use the Edit menu to cut and paste photos in the Gallery, but why bother? Drag and 
drop is a whole lot easier.

Other good stuff...
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Adding Part of a Photo to a Photo Gallery 

Let's say you have a snapshot of Ben and Jerry, which is a great picture, but you want to also have a 
photo of just Ben, without Jerry or the ice cream. Easy!

To add part of a photo to a Gallery:

Double-click the photo in the Gallery to open it in the Photo Workshop.

Select the part of the photo you want to make into a separate photo.

Click    

Drag the selection to a Gallery, either the one with the original photo or another one.

When EasyPhoto asks for a name for the "new" photo, type an eight-character filename (such as,
BENSOLO), and select a directory where you want to store it.

Note You are simply copying part of a photo. You in no way damage the original photo.

Note EasyPhoto stores the photo in JPEG format and automatically adds the .JPG extension to the 
filename you type. But if you like, you can select another file format (for example, Windows 
bitmap--BMP) in step 5.

Other good stuff...
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Organizing Photos in a Photo Gallery

You're never stuck with the order of the photos in a Gallery. You can:

Move a photo to another position in the same Gallery

Move a photo to a different Gallery

Remove a photo from the Gallery
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Moving Photos in a Photo Gallery 

You can rearrange the photos in a Gallery. To move a photo, drag it to a new position. As you drag, a 
black horizontal line marks the new position of the photo. After you drop the photo in its new location, the 
photo numbers change to show the new order of photos in the Gallery.

Note You can also use the Edit menu to cut and paste photos in the Gallery, but why bother? Drag and 
drop is a whole lot easier.

Other good stuff...
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Removing a Photo from a Photo Gallery 

Select the photo you want to remove.

Choose Delete Photo from Gallery from the File menu.

Note When you use your Photo Reader to add photos to a Gallery, EasyPhoto stores them in a special 
place: the PHOTO directory on your hard disk. When you ask to delete one of those photos from a 
Gallery, EasyPhoto checks to see whether the photo is in any other Gallery. If so, EasyPhoto 
removes the photo from the current Gallery but leaves the photo file in the PHOTO directory. It's 
like taking a picture out of your grandmother's photo album; you still have the picture, but the album
has a blank page with a faded area where the photo used to be. If the photo is not in any other 
Gallery, EasyPhoto asks whether you want to delete it from the hard disk. You must keep each 
photo in at least one Gallery. This is EasyPhoto's way of keeping unused photos from cluttering up 
your disk.

Note For photos stored on a CD, deleting a photo from a Gallery never deletes the original photo.

Note EasyPhoto doesn't remove a photo that you have open in the Photo Workshop.



Moving a Photo to Another Photo Gallery 

Arrange the two Gallery windows so that they are side by side on the screen.

Select the photo you want to move, and press the Alt key while you drag the photo to the other 
Gallery.

EasyPhoto adds the small representation of the photo, as well as the title and caption, to the second 
Gallery while deleting it from the first.

Note You can also use the Edit menu to cut and paste photos between Galleries, but why bother? Drag 
and drop is a whole lot easier.

Other good stuff...
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Saving a Photo Gallery 

To save a Photo Gallery:

In the Photo Gallery window, choose Save Gallery from the File menu.

Note When you save a Gallery for the first time, EasyPhoto asks you to name the Gallery. You can 
choose any name, up to 32 characters, that means something to you.



Opening a Photo Gallery 

In any Photo Gallery window, click    

In the Create or Open Photo Gallery dialog box, select the Gallery you want to open.
The list of existing Galleries shows those that you've made, plus the sample Gallery that comes with 
EasyPhoto, starting with the Gallery you used most recently.

Click OK.

Tip When you start EasyPhoto, it automatically opens all Galleries that are marked as "show at 
startup". For Galleries that you seldom use, you can turn off "show at startup" to reduce the clutter 
on your desktop. Choose Show at Startup from the File menu.

Other good stuff...

Creating a Photo Gallery

Showing a Gallery when EasyPhoto starts



Finding a Photo

You can search through your Galleries for a photo that has a certain word or phrase in the title or caption. 
You can also look for "sister" photos that resemble the selected photo.

To look for a photo with certain words in the title or caption:

In the Photo Gallery, choose Find Photos from the Edit menu.

Click the By Words tab of the Find Photo dialog box.

Type the key word or phrase you're looking for.

Tell EasyPhoto where to look. You can have it search either just the current Gallery or in all 
Galleries.

Click Find.
EasyPhoto shows you a new Gallery with copies of all photos that have a match with your search 
words.

To look for photos that resemble the selected photo:

In the Photo Gallery, select the photo whose sisters you want to find.

Choose Find Photos from the Edit menu.

Click the By Example tab of the Find Photo dialog box.

Tell EasyPhoto where to look. You can have it search either just the current Gallery or in all 
Galleries.

Click Find.
EasyPhoto shows you a new Gallery with copies of all photos that resemble the example photo.

Other good stuff...
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Changing the Photo's Title

When you first add a photo to a Gallery, EasyPhoto shows the photo's filename on the title bar. You can 
change the title to something more meaningful to you.

To change the photo's title:

Click the photo in the Gallery to select it.

Click    

In the Edit Photo Information dialog box, type a title in the box.
You can type up to 32 characters for the title, but there's room to show only about 12 characters on 
the title bar in the Gallery.

Click Close.

Tip To quickly change several titles, use the Previous and Next buttons to move to other photos in the 
Gallery without closing the dialog box.

Tip You can also add a caption for the photo. However, you can't edit the photo's filename, path, or 
where the photo file is stored (hard disk, diskette, or CD).



Adding a Caption to a Photo

You can add a caption, or notes, to a photo. The caption shows as part of the photo information you see 
when you click the title bar in the Photo Gallery. You can also show the caption in EasyPhoto slide shows 
and screen savers.

To add a photo caption:

Click the photo to select it.

Click    

In the Edit Photo Information dialog box, type a caption, up to 256 characters, in the box. (To start
a new paragraph, press Ctrl+Enter.)

Click Close.

Tip To quickly add several captions, use the Previous and Next buttons to move to other photos in the 
Gallery without closing the dialog box.

Tip You can also change the title of the photo. However, you can't edit the photo's filename, path, or 
where the photo file is stored (hard disk, diskette, or CD).



Getting Information about a Photo

In the Photo Gallery, click the photo's title bar. EasyPhoto shows you the title card, with this information:

A caption you added

The photo's filename and full path

The photo's file size (how much space it takes up on disk)

Where the photo is stored (hard disk, diskette, CD)

For photos on CDs, whether that CD is in the CD-ROM drive

Tip If the caption is too long to fit on the title card ("..." shows at the end of the caption), choose Edit 
Photo Information from the Edit menu to look at the text in a larger dialog box.

Other good stuff...
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Inserting a Photo into a Word-Processing Document

This part's easy. You can drag and drop a photo from the Photo Gallery and put it into any word-
processing document, such as a letter in Microsoft Word 6.0 for Windows.

To drag and drop a photo into a document:

Arrange the windows so that you can see both the Gallery and word processor windows.

Drag the photo from the Gallery to the word processor.
The cursor changes to an hourglass briefly while EasyPhoto and the word processor talk to each 
other, and then to the drop cursor to show that you can insert the photo.

Still holding down the mouse button, position the drop cursor where you want the photo, and then
release the mouse button to "drop" the photo into the document.

EasyPhoto puts a copy of the photo into the word processor. With most word processors, such as 
Word 6.0 for Windows, EasyPhoto puts the photo in a frame, and text wraps around this frame. You 
can move or resize this frame.

Tip Some older word processors, those that don't use the new OLE 2.0 technology, don't allow you to 
drag and drop photos. If you try it, the cursor changes to a "can't drop here" cursor. If that happens 
to you, you can still put a photo in your document. It just takes a few more steps. See the step-by-
step instructions by clicking the topic below, "Inserting a photo the long way".

Tip You can also drag and drop a photo, or part of a photo, from the Photo Workshop. The steps are 
the same.

Tip Your word processor treats a photo just like any other picture or clip art. You can use your word 
processor's tools to move or resize the photo. For the specifics, see the online Help for your word 
processor.

Other good stuff...
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Inserting a Photo the Long Way

If your word processor doesn't allow you to drag and drop a photo from EasyPhoto, follow these steps to 
put a photo into your document.

In the Photo Gallery or Photo Workshop, select the photo, or part of the photo, you want.

Choose Copy from the Edit menu.

In the word processor, position the cursor where you want to put the photo.

Choose Paste or Paste Special from the Edit menu.

Tip Your word processor treats a photo just like any other picture or clip art. You can use your word 
processor's tools to move or resize the photo. For the specifics, see the online Help for your word 
processor.



Inserting Part of a Photo into a Word-Processing Document

You have a great photo of yourself, but what you really need is just the head shot to put in a resume. No 
problem.

To put part of a photo into a document:

Double-click the photo in the Gallery to open it in the Photo Workshop.

Select the part of the photo you want to make into a separate photo.

Click    

Arrange the windows so that you can see both the Photo Workshop and word processor 
windows.

Drag the selection to the word processor.
The cursor changes to an hourglass briefly while EasyPhoto and the word processor talk to each 
other, and then to the drop cursor to show that you can insert the photo. Continue to hold down the 
mouse button.

When the drop cursor is over the spot where you want the photo, release the mouse button.
EasyPhoto puts a copy of the selected part of the photo into the word processor.

Tip Some older word processors, those that don't use the new OLE 2.0 technology, don't allow you to 
drag and drop photos. If you try it, the cursor changes to a "can't drop here" cursor. If that happens 
to you, you can still put a photo in your document. It just takes a few more steps. See the step-by-
step instructions by clicking the topic below, "Inserting a photo the long way".

Tip If you want to save part of a photo to use it again in another document, add the selected part to a 
Photo Gallery.

Tip Your word processor treats a photo just like any other picture or clip art. You can use your word 
processor's tools to move or resize the photo. For the specifics, see the online Help for your word 
processor.
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Making Changes to a Photo After It's in a Document

If you decide you don't like the way a photo looks in your document, you don't have to delete it and start 
all over. You can make changes to the photo in place.

To make changes to a photo in a document:

Double-click the photo
The Photo Workshop opens, either inside your word processor or in a separate window. Use the 
Workshop tools to make any changes you want. When you're finished, click anywhere in the document 
outside the photo to go back to your word processor. (If the photo opened in a separate window, choose 
Update and Return from the File menu to go back to your word processor.)

To replace a photo with another:

In the word processor, select the photo.

Drag and drop (or copy and paste) the new photo from the Gallery or Workshop to the word 
processor.

Note After you put a photo in a document, you can use your word processor to resize the photo. Select 
the photo and then drag a corner handle until the photo is the size you want. You can't use the 
Photo Workshop to resize the photo there.

Other good stuff...
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Cropping a Photo

In the Photo Workshop, click a selection button.
Click: To:

Select a rectangular area

Select a freeform area

Drag the mouse to select the area of the photo you want to keep.

Click    

EasyPhoto deletes everything outside the selected area.

Note If you crop a freeform area, EasyPhoto encloses it in an invisible rectangular frame. When you put 
the cropped photo in a document, text wraps around the frame; it doesn't follow the contours of the 
cropped photo.

Other good stuff...

Opening a photo in the Photo Workshop

Selecting part of a photo

Deleting part of a photo

Resizing a photo



Resizing a Photo

In the Photo Workshop, click    

Drag a handle to change the size of the photo.
As you move the mouse, an outline of the photo shows what's happening, and the status bar keeps 
you up-to-date on the actual photo size.

When the photo outline is the size you want, release the mouse button.

You can continue to adjust the size (repeat steps 1-3), or press the Esc key (or click another 
button in the toolbar) when you're done resizing the photo.

Note EasyPhoto keeps the proportions of the photo as you change the size.

Note After you put a photo in a document, you can use your word processor to resize the photo. Select 
the photo and then drag a corner handle until the photo is the size you want. You can't use the 
Photo Workshop to resize the photo there.

Tip Resizing a photo changes the dimensions so that you can, for example, fit it better into a letter or 
report. If you just want to magnify a photo to check the detail or work on a small area, use the 
Zoom commands instead.

Other good stuff...

Opening a photo in the Photo Workshop

Cropping a photo

Looking at a photo in more detail (zoom)

Positioning photos in a document



Rotating a Photo

In the Photo Workshop, click    

Drag any handle to turn the photo.
As you move the mouse, an outline of the photo shows what's happening, and, for the technically 
inclined, the status bar keeps you up-to-date on the precise rotation angle, in degrees.

When the photo outline is the angle you want, release the mouse button.

You can continue to rotate the photo (repeat steps 1-3), or press the Esc key (or click another 
button in the toolbar) when you're done rotating the photo.

Other good stuff...

Opening a photo in the Photo Workshop

Flipping a photo



Flipping a Photo

In the Photo Workshop, choose a Flip command from the Photo menu.
Choose: To:
Flip Horizontally Flip the current photo end for end, creating a mirror image of the photo

Flip Vertically Flip the current photo top to bottom

Tip If you are putting a photo into a document, you can flip the photo horizontally to change its 
composition so that it fits better with the layout of the document. For example, you want to put a 
picture of your grandmother on the left side of a letter, but the only picture you have shows her 
facing left, off the page. For a better design, flip the photo so that she faces toward the center of 
the page.

Tip Flipping a photo vertically is similar to rotating. To decide which works best for you, think of it like 
this: flipping creates a mirror image, which changes the composition of a photo. Rotating, in 
contrast, keeps the same arrangement of elements on the photo, but just turns everything upside 
down.

Other good stuff...

Opening a photo in the Photo Workshop

Rotating a photo



Changing the Brightness and Contrast of a Photo

Brightness, also called exposure, is the amount of light in a photo. Contrast is the difference between the 
light and dark areas of a photo. You can fix minor exposure problems. You can also make that picture of 
Seattle in winter look like Fiji. Well, almost.

To change the brightness and contrast:

In the Photo Workshop, click    

In the dialog box, drag the Brightness and Contrast sliders to make changes. (You can also 
click the slider bar, and the slider will move to that spot.)

The Before and After samples show you what the photo looks like now and how it will look if you 
actually make these changes.

Click OK to make the changes to the photo and close the dialog box.

Tip You can also change the brightness and contrast of just a selected part of the photo. Just make a 
rectangular or freehand selection before you start with step 1.

Tip For a quick way to start over with the original slider settings, click Restore.

Other good stuff...

Opening a photo in the Photo Workshop

Selecting part of a photo

Adjusting the colors of a photo



Adjusting the Colors of a Photo

In the Photo Workshop, click    

In the dialog box, drag the Red, Green, and Blue sliders to change the proportion of each color in
the photo. (You can also click the slider bar, and the slider will move to that spot.)

The Before and After samples show you what the photo looks like now and how it will look if you 
actually make these changes.

Click OK to make the changes to the photo and close the dialog box.

Tip You can also change the colors of just a selected part of the photo. Just make a rectangular or 
freehand selection before you start with step 1.

Tip For a quick way to start over with the original slider settings, click Restore.

Other good stuff...

Opening a photo in the Photo Workshop

Selecting part of a photo

Changing the brightness and contrast of a photo



Removing a Scratch from a Photo

In the Photo Workshop, click    

Drag the mouse to select the area of the photo that has the scratch.

Click    

In the dialog box, drag the sliders until the scratch disappears in the After sample.
The Before and After samples show you what the photo looks like now and how it will look if you 
actually make these changes.

Click OK to make the changes to the photo and close the dialog box.

Tip Start out with fairly low settings for Width (size of the scratch) and Sensitivity. Move the sliders 
only to the point where the scratch just disappears.

Tip For a quick way to start over with the original slider settings, click Restore.

Other good stuff...

Opening a photo in the Photo Workshop

Selecting part of a photo



Fixing a "Red-Eye" Problem

In the Photo Workshop, click    

Drag the mouse to select the area of the photo that has the red-eye problem. You don't have to 
get too precise, just close enough that EasyPhoto can distinguish between red eyes and red poppy 
flowers.

Click    

In the dialog box, drag the slider until the eyes look normal in the After sample.
The Before and After samples show you what the photo looks like now and how it will look if you 
actually make these changes.

Click OK to make the changes to the photo and close the dialog box.

Tip Start out with a fairly low setting for Color Correction. Move the slider only to the point where the 
red-eye effect just disappears.

Tip For a quick way to start over with the original slider settings, click Restore.

Other good stuff...

Opening a photo in the Photo Workshop

Selecting part of a photo

Adjusting the colors of a photo



Looking at a Photo in More Detail (Zoom)

In the Photo Workshop, click    

Click the zoom cursor on the center of the area you want to view in detail.
EasyPhoto increases the magnification of the photo.

Continue to click with the zoom cursor until you can see the detail you want, or up to a maximum 
magnification of about 8x.

Tip You can zoom out the same way. Click:

Tip To return quickly to normal view, without any magnification, choose Actual Size from the View 
menu.

Tip Magnifying a photo this way doesn't change the actual dimensions. If you want to change the size 
of a photo, to fit it into a report, for example, use the Resize command.

Other good stuff...

Opening a photo in the Photo Workshop

Resizing a photo



Making Changes to Part of a Photo

You can make these changes to a part of the current photo:

Adjust the colors

Change the brightness and contrast

Remove a scratch

Remove a red-eye problem
The idea is that first you select the part of the photo you want to work on. Then you follow the same steps 
you normally use to change the entire photo. Click one of the topics below for the step-by-step details.

Show me how to...

Open a photo in the Photo Workshop

Select part of a photo

Adjust the colors of a photo

Change the brightness and contrast of a photo

Remove a scratch from a photo

Fix a "red-eye" problem



Undoing a Change You Made to a Photo

If you make a mistake or simply don't like the results of the change you make in the Photo Workshop, 
choose Undo from the Edit menu to reverse the change. It's like it never happened.

The Undo command tells you exactly what you are undoing, such as Undo Crop.

Once you undo a change, the command name changes to Redo. Choose Redo to restore the change, 
essentially undoing the undo. This lets you compare two versions of the photo.

Tip If you really get lost and want to start over, close the Photo Workshop without saving the changes. 
Then open the photo again in the Workshop.



Saving the Changes You Made to a Photo

You can save the changes and replace the original photo, or you can save the changes with a new name 
or file format, creating another photo.

To save the changes and replace the original photo:

Click    

EasyPhoto saves the photo and updates its small representation in the Photo Gallery.

To save the changes with a new name:

Choose Save As from the File menu.

Type a new filename in the File Name box.

If you want, change the file format or the drive and directory where you want to store the photo.

Click OK.
EasyPhoto saves the new photo and puts a small representation of it in the Photo Gallery.

Note If the original photo came from a CD, you can't replace the photo. That's because CDs are 
designed so that you can only look at the photos, not make changes to them.    To save the 
changes to the photo, save the photo on your hard drive or a diskette.

Note If you're working with a photo from within a word-processing document, you can't save it with a new
name or format. You can only save the changes you make by replacing the original photo.

Tip You can save a copy of your photo in Windows BMP file format, for example, to use in another 
program that reads Windows bitmaps. Just follow the second set of steps and select Bitmap Files 
as the file type in step 3.



Printing a Photo

Open the photo you want to print in the Photo Workshop. (Double-click the small representation 
of the photo in the Photo Gallery.)

In the Photo Workshop, make any changes you want to the photo, such as cropping a portion or 
resizing it.

If you want to change the paper size and orientation, click Print Setup from the File menu.

Choose Print from the File menu.
EasyPhoto prints a single copy of your photo, using ClearPrint to get the best results from your 
printer.



Showing Photos in a Slide Show

You can show a group of your favorite photos as a slide show on your computer. EasyPhoto shows each 
photo for about 10 seconds and then moves on to the next. During the slide show, EasyPhoto gives you a
small set of controls, like those on a VCR, which you can use to control the show manually if you want.

To show your photos in a slide show on your computer:

Create a Photo Gallery with the photos you want to use in the slide show.

Choose Display Gallery as Slide Show from the File menu.

While the slide show is playing, you can use the slide show controls to control the show manually.
For example, you can pause the show or set it to show the photos just once instead of in a repeating loop.
To see what each control does, hold the mouse pointer over the control.

When you're finished viewing the slide show, click the Stop button, or press Esc.

Tip During a slide show, EasyPhoto can display a caption for each photo. Add your own captions to 
photos before you look at the slide show. Otherwise, EasyPhoto just uses the photo's title. You can 
also turn off the captions with the slide show controls.

Tip It's seldom a good idea to show your friends more than 3 hours of vacation slides at one time.

Other good stuff...

Creating a Photo Gallery

Adding a photo to a Photo Gallery

Sharing a slide show with someone else

Adding a caption to a photo

Changing the photo's title

Using the keyboard to control a slide show



Sharing a Slide Show with Someone Else

You can put a slide show of your photos on a diskette and give to a friend or family member to play on 
their computer, even if they don't have EasyPhoto on their computer. 

To create a slide show for someone else:

Create a Photo Gallery with the photos you want to use in the slide show.

Choose Save Slide Show to Diskette from the File menu.

Insert a blank diskette into drive A, and click OK.
EasyPhoto creates the slide show and puts it on the diskette. EasyPhoto also includes a copy of the 
EasyPhoto Slide Show viewer, which lets anyone with Windows play the slide show.

At the confirmation message, click OK.

Tip You'll find some nifty diskette labels in the EasyPhoto box. You can use these labels when you 
send a slide show to friends.

Tip When you give your friend the diskette with the slide show, explain how to play the show. Your 
friend needs to put the diskette in the drive, and then run the EasyPhoto Slide Show program, 
which is called EZVIEWER.EXE. When they see the EasyPhoto Slide Show viewer, they choose 
Play Slide Show from the File menu to start the show.

Tip You can fit a slide show with up to 24 photos on a single diskette. If you want to show more photos,
create another Gallery and make a second slide show.

Tip To see how the slide show will look before you give it to someone else, choose Display Gallery as 
Slide Show from the File menu.

Tip Before you make a slide show, add captions your photos. EasyPhoto shows the captions along 
with the photos.

Other good stuff...

Creating a Photo Gallery

Adding a photo to a Photo Gallery

Adding a caption to a photo

Changing the photo's title

Showing photos in a slide show

Using the keyboard to control a slide show



Using Photos as a Screen Saver

You can make a Windows screen saver from the photos in any Gallery.

From then on, whenever your computer remains inactive for 5 minutes (or for whatever time you have set 
in the Windows Control Panel), the photos in that Gallery appear, one by one, like a slide show on your 
screen.

To make a Windows screen saver from your photos:

Create a Photo Gallery with the photos you want to use as the screen saver.

Choose Use Gallery as Screen Saver from the File menu.
EasyPhoto creates the screen saver and does all the magic stuff behind the scenes to install the 
screen saver on your Windows desktop.

Note To change the screen saver, you can add photos to or remove photos from this Gallery. Or, you can
make another Gallery the screen saver by choosing the Use Gallery as Screen Saver command 
from that Gallery. You remove a screen saver by using the Desktop controls in the Windows 
Control Panel.

Note The screen saver works even if EasyPhoto is not open at the time.

Note If you installed a screen saver program from another company, you might need to turn it off before 
you can see your EasyPhoto screen saver. Try the steps above first. If you don't see your photos, 
then try turning off the other screen saver.

Tip Forget which Gallery you're using as a screen saver? Choose Create or Open Photo Gallery from
the File menu, and look in the list of existing Galleries. The note, "screen saver", identifies the 
Gallery you're using as the screen saver.

Other good stuff...

Creating a Photo Gallery

Adding a photo to a Photo Gallery

Adding a caption to a photo

Changing the photo's title

Turning off a screen saver



Making Windows Wallpaper from a Photo

You can make Windows wallpaper from the current photo in the Photo Workshop.

To make Windows wallpaper from one of your photos:

Open the Photo Gallery with the photo you want to use as the wallpaper.

Double-click the photo to open it in the Workshop.

In the Workshop, choose Install as Wallpaper from the File menu.
EasyPhoto tells Windows to use the photo as the background for your desktop.

Note You can make another photo the wallpaper by choosing this command while the new photo is 
opened in the Photo Workshop. You remove the wallpaper by using the Desktop controls in the 
Windows Control Panel.

Note The wallpaper remains on the desktop, even if you remove the photo from the Gallery.

Other good stuff...

Removing a photo from Windows wallpaper



Selecting Part of a Photo

To select a square or rectangular area:

In the Photo Workshop, click    

Press and hold the left mouse button as you drag the mouse from any corner of the area you 
want to select to the opposite corner.

Release the mouse button.
EasyPhoto draws a frame to show the area you selected.

To resize a rectangular selection:

Drag anywhere on the border of the selection frame.

To select an irregularly shaped area:

In the Photo Workshop, click    

Press and hold the left mouse button as you drag the mouse around the perimeter of the area 
you want to select.

Release the mouse button.
EasyPhoto draws a frame to show the area you selected.

To start a new selection:

After clicking a selection button, click outside the current selection and then redraw another one.

To add to an existing selection or create more than one selection area:

Hold down the Shift key as you draw another selection frame.

To deselect part of an existing selection:

Hold down the Alt key as you draw another selection frame. The second selection frame 
deselects that part of the original selection.

To cancel a selection:

Choose Deselect from the Edit menu (or press the Esc key). Nothing remains selected.
-or-



Choose Select Entire Photo from the Edit menu. The entire photo is selected.
-or-

After clicking a selection button, click outside the current selection.



Opening a Photo in the Photo Workshop

You bring a photo into the Photo Workshop to make changes to the photo. For example, you can remove 
a scratch from that picture from your family reunion.

You can make changes to a photo you see in a Photo Gallery. You can also make changes to a photo 
after you've inserted it into a word-processing document.

If the photo is in a Photo Gallery:

Double-click the photo
-or-

Choose Edit Photo in Workshop from the Gallery's Edit menu
If the photo is in a word-processing document:

Double-click the photo



Making Changes to a Photo

You bring a photo into the Photo Workshop to make changes to the photo. Here's what you can do to a 
photo:

Resize it

Crop the photo

Rotate it

Change the brightness and contrast

Adjust the colors

Remove a scratch

Fix a red-eye problem

Flip a photo

Show me how to...

Resize a photo

Crop a photo

Rotate a photo

Change the brightness and contrast of a photo

Adjust the colors of a photo

Remove a scratch from a photo

Fix a "red-eye" problem

Flip a photo



Deleting Part of a Photo

You can remove a selected part of a photo. This is the opposite of cropping, which deletes everything 
outside the selected area.

To delete part of a photo:

In the Photo Workshop, click a selection button.
Click: To:

Select a rectangular area

Select a freeform area

Drag the mouse to select the area of the photo you want to delete.

Choose Cut from the Edit menu, or press the Delete key.
EasyPhoto deletes everything inside the selected area.

Tip If you cut part of the photo, EasyPhoto stores that piece on the Clipboard. You can paste it into 
another photo, to the Photo Gallery, or to any other Windows application that can accept photos.

Other good stuff...

Opening a photo in the Photo Workshop

Selecting part of a photo

Cropping a photo

Resizing a photo



Getting Tips for Working with EasyPhoto

To see a helpful hint about EasyPhoto:

Click the EasyPhoto logo near the top of any Gallery .
The tips give you hints about using EasyPhoto, about using your photos creatively, and about how to 
dress for success.

Tip You can also choose EasyPhoto Tips from the Help menu in either the Gallery or the Workshop to
see a hint.



Hiding the Photo Gallery

When you first start EasyPhoto, the Photo Gallery is set to stay in front of all other windows. With the 
Gallery in front, it's easy to drag and drop photos to your word-processing documents. Sometimes, you 
might want to let the Gallery fall behind the other windows.

To hide the Gallery:

Choose Always on Top from the File menu.
-or-

Click    

The next window you select will come in front of the Gallery.

Note To keep the Gallery on top again, choose the command or click the button again. When the button 
is depressed, and a check mark shows next to the command, the Gallery is set to stay on top.

Tip You can also minimize the Gallery window to keep it out of the way. (The minimize button is in the 
upper-right corner of the Gallery window.) Double-click the minimized Gallery to restore it to its 
original size.

Other good stuff...

Inserting a photo into a word-processing document



Removing a Photo from Windows Wallpaper

If you get tired of the photo you put on your Windows wallpaper, you have a couple of choices for getting 
rid of it. If you just want another photo as wallpaper, open the photo in the Photo Workshop and make it 
into wallpaper the same way you did with the previous photo. But, if you decide you don't want to see any 
photo on your desktop, you can change the wallpaper to something else...or to nothing at all.

To change the Windows wallpaper:

In the Windows Program Manager, double-click the Control Panel icon. (You'll find the Control 
Panel icon in one of the Windows Program Groups.)

In the Control Panel window, double-click the Desktop icon.

In the Wallpaper group, select another bitmap file in the File list.
If you're feeling conventional, pick one of the standard Windows wallpapers. (Argyle is especially 
tacky.) If you want bare walls, select None (at the top of the list).

For more Help on other Desktop options, click Help in the Desktop dialog box.

Click OK.

Note You can follow these steps word for word if you're using Windows 3.x. If you've upgraded to 
Window 95, the principles are the same even though some of the details will differ. For example, to 
find the Control Panel, you point to Settings on the Start menu.

Other good stuff...

Making Windows wallpaper from a photo



Positioning Photos in a Document

Once you put a photo into a word-processing document, you can arrange the layout of the photo and text.
Here's how to handle photos in a couple of popular word processors.

Microsoft Word 6.0 for Windows
When you drag and drop a photo into Word, EasyPhoto automatically puts the photo in a frame. Text 
automatically wraps around the frame.

To move the photo, click it in Word and drag it to another position.

To resize the photo, click it and drag one of the handles at the corners.

Microsoft Works 3.0 for Windows
When you drag and drop a photo into Works, EasyPhoto places the photo where you were last working in
the Works document, in-line with text. The line spacing increases to make room for the photo.

To move the photo, go to Page Layout view (choose Page Layout from the View menu). Then, click the 
photo and drag it to another position. You can't move the photo below the last paragraph on a page.

To resize the photo, click it and drag one of the handles at the corners.

To make the text wrap smoothly around the photo, select the photo and then choose Picture/Object from 
the Format menu. Go to the Text Wrap tab of the dialog box. Under Wrap, choose Absolute, and click 
OK.

WordPerfect 6.1 for Windows
When you drag and drop a photo into WordPerfect, EasyPhoto places the photo where you drop it on the 
page.

To move the photo, click it in WordPerfect and drag it to another position.

To resize the photo, click it and drag one of the handles at the corners.

To make the text wrap smoothly around the photo, select the photo and then choose Edit Box from the 
Graphics menu. In the toolbar that WordPerfect puts up, click the Wrap button. Then, in the Wrap Text 
dialog box, choose how you want text to wrap around the photo and click OK.



Using the Photo Reader Manually

Although it's simpler and more precise to let your Photo Reader work automatically, sometimes you might 
want to use the Photo Reader by hand. For example, you can copy a part of a large photo or piece of art 
that won't fit in the Photo Reader.

To use the Photo Reader manually:

Connect your Photo Reader. To do this, follow the steps in the booklet, "Using Your EasyPhoto 
Reader", which came in the EasyPhoto Reader box.

Separate the Photo Reader from the feeder (bottom part). (The booklet tells you how to do this, 
too.)

Back at your computer screen, open the Photo Gallery where you want to put the photo. 

Click    

In the Add Photos to Gallery dialog box, click the Photo Reader or Camera button.

Place the photo, face up, on your desk, and lay the Photo Reader on it. Look through the gray 
plastic cover to line it up with the edge of the photo. When the warm-up message says the Photo Reader 
is ready, press the Start button on the top of the Photo Reader, and start moving the Photo Reader slowly 
and smoothly across the photo.

The speed indicator bar shows how you're doing. Try to keep the indicator in the green. If the 
indicator moves into the yellow, slow down.

When you get to the end, press the Start button again to stop. Or, wait a few seconds without moving
the Photo Reader, and it stops copying automatically.

If you don't like the results, which you can preview in the dialog box, click Cancel, and then start over
with this step.

Click Add to Gallery to put the photo in the current Gallery.

At the Name Photo dialog, type a name for the photo.

To add more photos to the Gallery, repeat steps 6-8. When you're finished, click Close.

Tip If you don't have a Photo Reader but want to find out how to get one, click here.

Other good stuff...

Creating a Photo Gallery with your Photo Reader

Adding a photo with the Photo Reader



Showing a Gallery When EasyPhoto Starts

When you first create a Photo Gallery, EasyPhoto sets it to show on your desktop every time you start the
program. So the Gallery is right at hand when you need it. But if you have a lot of Galleries, you might 
want to automatically open only the ones you use most often. The others you can open just when you 
need them.

To turn off "show at startup" for a Gallery:

Go to the Gallery you don't want to show at startup.

In the File menu, a check mark next to Show at Startup shows that the Gallery is set to open 
automatically when EasyPhoto starts. Choose this command to turn it off.
To turn "show at startup" back on for a Gallery:

Open the Gallery you want to show at startup.

Choose Show at Startup from the file menu.
The check mark next to the command shows that the Gallery is set to open automatically when 
EasyPhoto starts.

Other good stuff...

Opening a Photo Gallery



Starting EasyPhoto from Your Word Processor

With Microsoft Word 6.0 for Windows, EasyPhoto adds a button to the toolbar. You can use this button as 
a shortcut for starting EasyPhoto without going back to the Program Manager.

To start EasyPhoto from Microsoft Word 6.0:

Click the EasyPhoto button in the Word toolbar.

Note If you are using a word processor other than Word 6.0, you need to start EasyPhoto the standard 
way, by double-clicking the EasyPhoto icon in the Program Manager.



Turning Off a Screen Saver

If you get tired of the photos you're using as your Windows screen saver, you change them or turn it off.

If you just want to use different photos as the screen saver, open the screen saver Gallery and change 
the photos. Or, make another Gallery the screen saver. But, if you decide you don't want to see any 
photos as your screen saver, you can simply turn it off.

To turn off the EasyPhoto screen saver:

In the Windows Program Manager, double-click the Control Panel icon. (You'll find the Control 
Panel icon in one of the Windows Program Groups.)

In the Control Panel window, double-click the Desktop icon.

In the Screen Saver group, select None in the Name list.
Or, you can select any of the other available screen savers in the list. You can even select Flying 
Windows if you have a high tolerance for kitsch.

Click OK.

Note When you turn off the EasyPhoto screen saver, you don't damage the photos you were using. The 
photos remain safely in their Gallery, and you can use them as a screen saver or in your 
documents at any time.

Note You can follow these steps word for word if you're using Windows 3.x. If you've upgraded to 
Window 95, the principles are the same even though some of the details will differ. For example, to 
find the Control Panel, you point to Settings on the Start menu.

Other good stuff...

Using photos as a screen saver



Using the Keyboard to Control a Slide Show

When you display a slide show of your photos on your computer, EasyPhoto provides a small set of 
controls, like those on a VCR, which you can use to control the show manually if you want. But you can 
also hide the controls and use the keyboard to control the show.

To do this: Press this key:

Hide the controls Alt+F4

Go to the next slide Right arrow key

Go to the previous slide Left arrow key

Pause/Play Enter (acts as a toggle)

Stop the show Esc

Redisplay the controls Any other key

Other good stuff...

Showing photos in a slide show

Sharing a slide show with someone else



Setting the Resolution of Your Photo Reader

Your Photo Reader came set to create photos with a resolution of 133 dpi (dots per inch), which gives 
good detail yet keeps the file size small. You can change this default resolution.

To change the resolution of the Photo Reader:

Exit EasyPhoto.
Before you exit, you might want to print this Help topic so that you don't have to remember all the 
steps. To print the topic, choose Print Topic from the File menu.

Using any simple text editor, such as Windows Notepad, open the EZPHOTO.INI file.
You'll find the EZPHOTO.INI file, as well as Notepad, in your WINDOWS directory.

At the line that reads "PHOTOREADER_RESOLUTION", replace the dpi setting with another 
number, up to a maximum of 1200 dpi.

Save the file and exit the text editor.

Start EasyPhoto.
From now on, all photos you copy with the Photo Reader will have the resolution you specified. You 
can change the resolution again at any time.

Tip Go easy when changing to a higher resolution. Past a certain resolution you really can't see an 
improvement in photo quality, but working with high-resolution photos bogs down your computer 
and can eat up a lot of hard disk space. As a practical matter, a resolution of 133 dpi works fine for 
viewing photos on your screen. For printing photos with some high-quality printers, you might see a
slight improvement with resolutions up to 200 dpi. If you want to try using resolutions other than 
133 dpi, try copying the same photo at several different resolutions. Then, to get the best 
performance, choose the lowest resolution that gives you the quality you want.

Note In step 3, if you don't see the line that reads "PHOTOREADER_RESOLUTION" in your 
EZPHOTO.INI file, close the file and use the Photo Reader to copy a photo at the standard 
resolution. Then come back to this set of steps. You must use your Photo Reader at least once 
before you can change the resolution.
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Add Photos to Gallery button...
...looks like this. Click it to add one or more photos to the current Gallery. You'll find it on the 
Photo Gallery toolbar.



Adjust Color button...
...looks like this. Click it to change the colors of a photo. You'll find it on the Photo Workshop 
toolbar.



application...
...a computer software program, such as Microsoft Works for Windows or WordPerfect 
or...well, EasyPhoto.



brightness...
...the amount of light in a photo, also called "exposure" by photographers.



Brightness / Contrast button...
...looks like this. Click it to change the brightness or contrast of a photo. You'll find it on the 
Photo Workshop toolbar.



buttons on the toolbar...
...the square boxes, with little pictures on them, below the menus in EasyPhoto. Each button 
gives you a short-cut. Hold the mouse cursor over any button to see its name, and, in the 
Photo Workshop, look in the status bar to see what the button does.



CD...
...compact disc that stores photos and other information. (Your EasyPhoto program came on a 
CD.)



ClearPrint...
...the neat bit of technology, developed at Storm Software, that EasyPhoto uses to get the best
results out of your printer. You can't see it or touch it, but it's the reason your printed photos, 
and documents with photos, come out looking so nice.



ClearScan...
...another neat bit of technology, developed at Storm Software, that EasyPhoto uses to get the 
best results out of your Photo Reader or a scanner. With ClearScan, the photos you copy into 
your computer come out sharp and clear, with colors as bright and vivid as in the original 
photo.



Clipboard...
...a temporary storage place that Windows uses to let you move information. When you cut, 
copy, and paste, you are using the Clipboard.



contrast...
...the difference between the light and dark areas of a photo. The lower the contrast, the more 
blah-gray the photo.



crease...
...what happens to your photo when your Aunt Louise sits on it. If you make an electronic copy 
of the photo with the Photo Reader, the crease might show as a white line. Fix it as you would 
a scratch, in the Photo Workshop.



Create or Open Photo Gallery button...
...looks like this. Click it to create a new Photo Gallery or open an existing one. You'll find it on 
the Photo Gallery toolbar.



crop...
...to trim and discard the outer edges of a photo, leaving only the smaller area that interests 
you. For example, you can crop a birthday photo to show just the cake. Use the Photo 
Workshop.
Also, something that farmers harvest, but that has nothing to do with photos.



Crop button...
...looks like this. Click it to delete all but the selected part of a photo. You'll find it on the Photo 
Workshop toolbar.



desktop...
...in Windows, the background of the computer screen. Program icons and windows appear on
top of the desktop. When you first install Windows, the desktop is a gray background. You can 
cover it with a Windows pattern, such as Scottie dogs, or use EasyPhoto to display one of your
photos on the desktop. Now, really, which would you prefer?



digital camera...
...a camera that records photos in a way that can be used by computers, rather than on 
conventional negatives or slides.



drag...
...an action you do with a mouse. To drag, click and hold down the left mouse button and then 
move the mouse.



drag and drop...
...a way of copying something from one window to another on your screen using the mouse. To
drag and drop a photo, for example, click and hold down the left mouse button on the photo. 
Then move the mouse. The mouse cursor changes to show you're moving the photo. When 
the photo is over the place you want to drop it, release the mouse button. (Some older 
computer programs don't let you drag and drop. In that case you can copy and paste photos.)



drop cursor...

...when you drag and drop to copy a photo from one window to another, the mouse cursor 
changes shape to show that the window is ready to receive the photo. (Some older computer 
programs don't let you drag and drop.)



Edit Photo Information button...
...looks like this. Click it to change the title or caption of a photo. You'll find it on the Photo 
Gallery toolbar.



extension...
...the last three characters, after the period, in Windows filenames. The extension usually 
shows the file format. For example, the extension ".BMP" indicates a Windows bitmap file, and
the extension ".JPG" indicates the JPEG file format used by EasyPhoto.



file format...
...the internal structure of a file stored on your computer. Each software program, such as 
EasyPhoto, can read and write specific formats. If you're technically minded, you might care 
that EasyPhoto can write photos in JPEG (.JPG), Windows bitmap (.BMP), and "device-
independent bitmap" (.DIB). EasyPhoto can read photos in those three formats, plus TIFF 
(.TIF), GIF, and Kodak Photo CD (.PCD). If you're not technically minded, don't worry about it. 
EasyPhoto takes care of formats without your having to do anything special.



filename...
...the name your computer uses to keep track of a file, such as a photo file. With Windows 3.x, 
you can use names of up to eight characters plus a three-character extension. With Windows 
95, you can use longer filenames.



flip...
...to turn a photo end for end (flip horizontally) or top to bottom (flip vertically), creating a mirror
image of the original photo. You use the Workshop to flip photos.



frame...
...in a word-processing document, a box that holds a photo so that you can easily change its 
position. When you move the frame, the word processor automatically makes room for it at the
new location.



Gallery name...
...a descriptive name you give to a collection of photos in a Photo Gallery. The name can be up
to 32 characters.



handles...
...small indicators that show you can use the mouse to change a photo in the Photo Workshop.
Handles appear when you are resizing or rotating a photo or making a rectangular selection.
In your word processor, handles show when you select a photo you inserted with EasyPhoto. 
You drag a corner handle to resize the photo.



jewel box...
...the plastic box that holds a CD. For Photo CDs, the jewel box shows small, numbered prints 
of the photos on the CD. (You have to think of your photos as jewels for the term to make any 
sense.)



JPEG...
...a file format (with the filename extension .JPG), which EasyPhoto uses to store photos in 
your computer. With the JPEG format, EasyPhoto can compress your photos, saving space on
your hard disk, without sacrificing photo quality. And those initials? Joint Photographic Experts 
Group, which sounds like a government agency but it's not.



Kodak Photo CD...
...a compact disc, created with Kodak technology, that can store your photos. You take your 
film, negatives, or slides to a film developer, and later they give you back a disc you can slip 
into your computer's CD-ROM drive.



marquetry...
...an inlay of ivory or wood used to decorate furniture. (This has nothing to do with photos. We 
just thought you'd like to know.)



Move button...
...looks like this. Click it to drag a photo to a document or to the Photo Gallery. You'll find it on 
the Photo Workshop toolbar.



obtund...
...to dull or deaden, as in: watching TV obtunds creativity.



OLE...
...stands for Object Linking and Embedding, which is just computer-speak for one of the ways 
two modern Windows programs can talk to each. When you put a photo into Word, for 
example, EasyPhoto uses OLE to tell Word that it will take care of the photo. So, when you go 
to print the document, Word handles the text, but when it gets to the photo, it tells EasyPhoto, 
"OK, you take over." That's why you get such great results printing photos, whether from Word 
or anywhere else. EasyPhoto is doing the work. (And you thought we were going to talk about 
another kind of bull!)



pathname...
...the complete name and location of a file. The pathname includes not only the filename but 
also the drive and directory where the file is stored on your computer.



photo caption...
...a short description or notes you can add for a photo. The caption shows when you click the 
title bar beneath the photo in the Gallery. EasyPhoto also shows these captions when you 
show photos as a slide show or as a screen saver.



Photo Gallery...

...a place where you store your photos in EasyPhoto. You use the Gallery to view and organize
collections of photos.



photo number...
...the number, to the side of the photo in the Gallery, that shows the relative position of the 
photo in the Gallery.



Photo Reader...

...a simple, compact, easy-to-use piece of computer hardware that lets you make electronic 
copies of your photos and put them into your computer.



photo title...
...a word or two that identifies the photo in the Gallery. The title shows on the title bar beneath 
the photo. When you first add a photo to a Gallery, the title is simply the filename. You can 
change the title to something better.



Photo Workshop...
......a place where you make changes to your photos in EasyPhoto. You use the Workshop to 
crop, resize, rotate, remove scratches, and adjust the color or brightness and contrast of 
photos.



red-eye...
...the problem you have when you take flash pictures of people with some cameras. The flash 
reflects off the eye in such a way that everyone looks like some strange alien or a reptile. You 
can use the Workshop to fix a red-eye problem in a photo.



Remove Red-Eye button...
...looks like this. Click it to fix a red-eye problem in a photo. You'll find it on the Photo 
Workshop toolbar.



Remove Scratch button...
...looks like this. Click it to remove the selected scratch from a photo. You'll find it on the Photo 
Workshop toolbar.



resize...
...to change the size of a photo, either to enlarge or reduce it. You use the Photo Workshop to 
resize photos.



Resize button...
...looks like this. Click it to change the size a photo. You'll find it on the Photo Workshop 
toolbar.



resolution...
...the amount of detail in a photo. The higher the resolution, the more detail, but the slower the 
performance and the larger the file on your hard disk. For example, the EasyPhoto Reader is 
set to create photos with a resolution of 133 dpi (dots per inch), which gives good detail yet 
keeps the file size small. You can change the resolution of the Photo Reader, up to 1200 dpi if 
you want.



rotate...
...to turn a photo clockwise or counter-clockwise. You use the Photo Workshop to rotate 
photos.



Rotate button...
...looks like this. Click it to turn a photo clockwise or counter-clockwise. You'll find it on the 
Photo Workshop toolbar.



rubber chicken...
...a sight gag that for some reason invariably makes people laugh. Skeptical? Check out the 
photo of the rubber chicken, which is #87 in the Photo Clip-Art Gallery.



Save button...
...looks like this. Click it to save any changes you made to the photo. You'll find it on the Photo 
Workshop toolbar.



scan...
...the technical term for using the Photo Reader to convert photos and other printed art into an 
electronic form that you can use in your computer. Common usage: "Honey, I just scanned the 
kids."



scanner...
...the technical, generic term for the EasyPhoto Reader and related devices, which convert 
photos and other printed art into an electronic form that you can use in your computer.



scratch...
...what happens to your photo when your visiting 3-year-old niece finds a sharp pointy object 
next to your shoebox full of photos. If you make an electronic copy of the photo with the Photo 
Reader, the scratch usually shows as a white line. Fix it in the Photo Workshop, and next time 
be more careful about what you leave lying around the house.



screen saver...
...a series of photos or other moving pattern that shows on your computer screen whenever 
you don't move the mouse or type for some time. The idea is to keep the display moving to 
prevent damage to the monitor. Sure you could use flying waffle irons as your screen saver, 
but aren't your own photos more interesting?



select...
...to pick or choose an object on screen. Usually, you click the object with the mouse to select 
it.
Also, in the Photo Workshop, "select" means to pick out part of a photo, by defining a 
rectangular or freeform area. You click the Select Rectangle or Select Freehand button to 
begin drawing a selection.



Select Freehand button...
...looks like this. Click it to select an irregular area of a photo. You'll find it on the Photo 
Workshop toolbar.



Select Rectangle button...
...looks like this. Click it to select a rectangular area of a photo. You'll find it on the Photo 
Workshop toolbar.



Show Help button...
...looks like this. Click it to get Help on the Photo Gallery or Photo Workshop. You'll find it on 
the Photo Gallery and Workshop toolbars.



slide show...
...a way to display a whole Gallery full of photos one by one on your computer screen. You can
also copy a slide show to a diskette and give it to a friend to look at on another computer.



slide show controls...
...a small set of VCR-like controls that appear on your screen whenever you play a slide show. 
You can use the controls to move among the photos or to stop the show. Or, you can ignore 
the controls and just let the slide show play automatically.



slide show viewer...
...a small EasyPhoto program that displays a slide show on any computer, even if EasyPhoto 
is not installed. For example, when you make a slide show and copy it to a diskette to share 
with a friend, EasyPhoto also puts the viewer on the diskette. Your friend doesn't need 
EasyPhoto to see the slide show.



startup...
...when you run the EasyPhoto program. At startup EasyPhoto shows you all Galleries that are
marked "show at startup".



title bar...

...a button, beneath each photo in the Gallery, which shows the title of the photo. You click the 
button to see more information about the photo. You can change the title to anything you want.



title card...

...shows the photo caption (a brief description of the photo), the photo's filename, and where 
the photo file is stored (hard disk, diskette, or CD). To display the title card, click the title bar 
beneath the photo.



toolbar...
...the row of buttons below the menus in EasyPhoto. Each button gives you a short-cut. Hold 
the mouse cursor over any button to see its name, and, in the Photo Workshop, look in the 
status bar to see what it does.



TWAIN...
...the standard "language" that the Photo Reader uses to communicate with your computer. 
Most digital cameras and other similar devices use this same standard, and in fact, those other
"TWAIN devices" work great with EasyPhoto.
Some people will tell you that TWAIN stands for Technology Without An Important Name, but 
here's a secret: the people who designed TWAIN just made up the name. Maybe they were all 
fans of "Huckleberry Finn".



wallpaper...
...a photo or other picture that you use to cover up the boring gray background of the Windows
desktop on your computer screen. Do you really want Window "red bricks" as the wallpaper? 
Of course not. Use EasyPhoto to make wallpaper from one of your photos. It's easier than 
putting up wallpaper in your kitchen, and there's no messy paste that sticks in your hair.



wrap...
...the flow of text around a photo in a word-processing document. Without word wrap, text 
stops above the photo and starts again below the photo, even if the photo only takes up part of
the line width. Most word processors let you turn word wrap on or off. 



yoicks...
...a hunting cry, used in the old days, to urge the dogs after the fox. (This has nothing to do 
with photos. It's just that the Y section of the Glossary was looking a little sparse.)



Zoom In button...
...looks like this. Click it to magnify your view of the part of the photo you click. You'll find it on 
the Photo Workshop toolbar.



Zoom Out button...
...looks like this. Click it to reduce the magnification of the part of the photo you click. You'll find
it on the Photo Workshop toolbar.



Miscellaneous pop-ups go below here:



How to get a Photo Reader

With a Photo Reader, you can make electronic copies of your photos (or anything else on 
paper, for that matter) and store them in your computer. You can buy a Photo Reader from 
Storm Software. Call 1-800-275-5734.



pop-up definition...
...gives the definition of an unfamiliar word in a window like this. Click anywhere with the 
mouse to close this pop-up window.





The Photo Workshop

You use the Photo Workshop to make changes to photos. For example, you can crop your ski photo and 
rotate it a bit before you put it in a letter to your friends. They'll never suspect you were just on the bunny 
slope. Here are some other things you can do:

Resize, rotate, or flip the photo

Adjust the colors or change the brightness or contrast

Remove a scratch (or "  crease  "  ) from the photo

Get rid of ugly "red-eye" effects
When changing a photo, the toolbar is your friend. Each button is a shortcut to get the job done. To learn 
about each button, use the mouse to put the cursor over the button. A yellow label tells you the name of 
the button, and the status bar tells you what it does.

By default, changes you make apply to the whole photo. But you can also change just part of the photo. 
Use the Selection buttons to select a rectangular or an irregularly shaped area.

If you make a mistake or simply don't like the change you made, you can back up a step. Choose Undo 
from the Edit menu.
After you get the photo the way you like it, you can drag and drop it into a word-processing document. 
You can save the changes you made to the photo, either replacing the old one or making a new one, or 
you can discard your changes. You can also print the photo. Or, for something a little more fun, make the 
photo into the Windows wallpaper on your computer desktop.
Show me how to...

Resize a photo

Crop a photo

Rotate a photo

Change the brightness and contrast of a photo

Adjust the colors of a photo



Remove a scratch from a photo

Fix a "red-eye" problem

Flip a photo

Making changes to part of a photo

Undo a change I made to a photo

Look at a photo in more detail (zoom)

Save the changes I made to a photo

Print a photo

Make Windows wallpaper from a photo



File Menu



Save/Update Command (File Menu)

You click this button or choose this command to save the changes you made to the photo. When you 
save the changes, you replace the original photo.

If you want to save the changes as a new photo, but keep the original too, choose Save As from the File 
menu.

Note This command is available only if you've made changes to the photo.

Note If the original photo came from a CD, you can't replace the photo. That's because CDs are 
designed so that you can only look at the photos, not make changes to them.    To save the 
changes to the photo, save the photo on your hard drive or a diskette.

Note EasyPhoto can't save photos with TIFF, GIF, or Photo CD file format. If you ask to save a photo that
has one of those formats, EasyPhoto shows you the Save As dialog box, where you can save the 
photo with another format.

Note The Update command is available when you are using the Photo Workshop to change a photo that
you put in a word-processing document. Update means the same as Save.

Show me how to...

Save the changes I made to a photo



Save As Command (File Menu)

You choose this command to save the photo with a new name, location, or file format.

If you give the photo a new name or location, EasyPhoto saves the new photo and adds a representation 
of it to the Photo Gallery. The original photo remains as it was, where it was.

Note You can't save a photo on a CD, even if the original photo came from a CD. That's because CDs 
are designed so that you can only look at the photos, not make changes to them.    To save the 
changes to the photo, save the photo on your hard drive or a diskette.

Note This command is not available when you are using the Photo Workshop to change a photo that you
put in a word-processing document. To save the photo with another name or format, open the 
Gallery that has the photo, open the photo in the Photo Workshop, and then save the photo from 
there.

Show me how to...

Save the changes I made to a photo

Open a Photo Gallery



Save As Dialog Box

You use this dialog box to save the photo with a new name, location, or file format.

Dialog box options
File Name Type a name for the photo, up to eight characters. You can also type a three-character

extension, or EasyPhoto will give it one for you.

Directories Select the directory where you want to save the photo.

Drives Select the drive where you want to save the photo.

Save File as Type Select the file format you want for the photo.

Note You can't save a photo on a CD, even if the original photo came from a CD. That's because CDs 
are designed so that you can only look at the photos, not make changes to them.    To save the 
changes to the photo, save the photo on your hard drive or a diskette.

Note If you give the photo a new name or location, EasyPhoto saves the new photo and adds a 
representation of it to the Photo Gallery. The original photo remains as it was, where it was.

Show me how to...

Save the changes I made to a photo



Install as Wallpaper Command (File Menu)

You choose this command to make Windows wallpaper from the current photo in the Photo Workshop.

EasyPhoto tells Windows to use the photo as the background for your desktop.

Note You can make another photo the wallpaper by choosing this command while the new photo is 
opened in the Photo Workshop. You remove the wallpaper by using the Desktop controls in the 
Windows Control Panel.

Note The wallpaper remains on the desktop, even if you remove the photo from the Gallery.

Show me how to...

Make Windows wallpaper from a photo

Remove a photo from Windows wallpaper



Show Gallery Command (File Menu)

You choose this command to display the Photo Gallery that contains the information about the current 
photo. This is a quick way to find your way back to the right Gallery if you've been working with several 
photos and Galleries.



Print Setup Command (File Menu)

You choose this command to change page size and orientation and other options that are available for 
your printer.



Print Setup Dialog Box

You use this dialog box to change orientation and page size and other options that are available for your 
printer.

Dialog box options
Orientation Select Portrait to print a photo vertically on a page, Landscape to print it horizontally. 

For example, you might need to change the orientation to Landscape to get a wide photo
to fit on one page.

Paper Size Choose a paper size from the list.

Note These are the two common setup options you might want to change for printing photos. Your 
printer might also let you change other settings. See your printer documentation for more 
information.



Print Command (File Menu)

You choose this command to print a single copy of the photo displayed in the Photo Workshop.

EasyPhoto goes right ahead and prints the photo, using the current printer setup, without bothering you 
with more questions or dialog boxes. EasyPhoto uses ClearPrint to get the best results from your printer.

Show me how to...

Print a photo



Exit and Return To ... Command (File Menu)

You choose this command when you've finished working in the Photo Workshop.

EasyPhoto closes the Photo Workshop window and takes you back to where you were working before 
you opened the Photo Workshop, either to the Gallery or to another program.

If you made changes to the photo, EasyPhoto asks you whether you want to save your changes.



Edit Menu



Undo/Redo Commands (Edit Menu)

You use the Undo command to reverse the last change you made. The command tells you exactly what 
you are undoing, such as Undo Remove Scratch.

Once you undo a change, the command name changes to Redo. Choose Redo to restore the change, 
essentially undoing the undo. This lets you compare two versions of the photo.

If you haven't made any changes, the command name says Can't Undo.

Note The Undo command can't help with a bad hair day.

Show me how to...

Undo a change I made to a photo



Cut Command (Edit Menu)

You choose this command to remove the selected area from the photo and place it on the Clipboard. You 
can then move (paste) the selection to another place on the photo, to another photo, or to any other 
Windows application that can accept photos.

The cut selection stays on the Clipboard until you cut or copy something else. There's only room for one 
selection on the Windows Clipboard.

Note This command is available only if you've selected part or all of the photo.

Show me how to...

Select part of a photo

Insert a photo into a word-processing document

Insert part of a photo into a word-processing document

Adding part of a photo to a Photo Gallery



Copy Command (Edit Menu)

You choose this command to make a copy of the selected area of the photo and place it on the Clipboard.
You can then paste the selection to another place on the photo, to another photo, or to any other 
Windows application that can accept photos.

The copied selection stays on the Clipboard until you cut or copy something else. There's only room for 
one selection on the Windows Clipboard.

Note This command is available only if you've selected part or all of the photo.

Show me how to...

Select part of a photo

Insert a photo into a word-processing document

Insert part of a photo into a word-processing document

Add part of a photo to a Photo Gallery



Paste Command (Edit Menu)

You choose this command to move a copy of the Clipboard contents to the current photo.

The Clipboard contains whatever you last cut or copied. This might be a part of the current photo, another
photo, or even some text from a word-processing document. But, in the Photo Workshop, you can only 
paste other photos or parts of photos into the current photo.

Note This command is available only if you've cut or copied a photo or part of a photo.



Select Entire Photo Command (Edit Menu)

You choose this command to select the whole photo. When you select a photo, changes you make, for 
example to the colors or contrast, apply to the entire photo.

When you first open a photo in the Photo Workshop, you are working with the entire photo. You can 
choose this command if you selected a part of the photo and then want to work with the whole photo 
again.

Show me how to...

Select part of a photo



Deselect Command (Edit Menu)

You choose this command to cancel a selection. Nothing remains selected.

When nothing is selected, changes you make, for example to the colors or contrast, apply to the entire 
photo.

Tip You can also press the Esc key to cancel a selection.

Show me how to...

Select part of a photo



Photo Menu



Crop Command (Photo Menu)

You click this button or choose this command to "crop" the current photo, that is, to delete everything 
outside the selected area.

Note Before cropping, you need to select part of the photo. You can select a rectangular or freeform 
area.

Show me how to...

Select part of a photo

Crop a photo

Delete part of a photo



Resize Command (Photo Menu)

You click this button or choose this command to change the size of the current photo.

EasyPhoto puts handles in the photo, which you drag to change the size. You can see the current size of 
the photo at the right side of the status bar.

Press the Esc key, or click another button in the toolbar, to stop resizing.

Note EasyPhoto keeps the proportions of the photo as you change the size.

Note Resizing a photo changes the dimensions so that you can, for example, fit it better into a letter or 
report. If you just want to magnify a photo to check the detail or work on a small area, use the 
Zoom commands instead.

Note The Resize command is not available for a photo in a word-processing document. However, you 
can use your word processor to resize the photo. Select the photo and then drag a corner handle 
until the photo is the size you want. 

Show me how to...

Resize a photo

Look at a photo in more detail (zoom)



Rotate Command (Photo Menu)

You click this button or choose this command to rotate the current photo.

EasyPhoto puts handles in the photo, which you drag to turn the photo.

Press the Esc key, or click another button in the toolbar, when you're through rotating the photo.

Show me how to...

Rotate a photo



Flip Horizontally Command (Photo Menu)

You choose this command to flip the current photo end for end, creating a mirror image of the photo.

Tip If you are putting a photo into a document, you can flip the photo to change its composition so that 
it fits better with the layout of the document. For example, you want to put a picture of your 
grandmother on the left side of a letter, but the only picture you have shows her facing left, off the 
page. For a better design, flip the photo so that she faces toward the center of the page.

Show me how to...

Flip a photo

Rotate a photo



Flip Vertically Command (Photo Menu)

You choose this command to flip the current photo top to bottom.

Flipping a photo is similar to rotating, except flipping creates a mirror image, which changes the 
composition of a photo. Rotating, in contrast, keeps the same arrangement of elements on the photo, but 
just turns everything upside down.

Show me how to...

Flip a photo

Rotate a photo



Brightness/Contrast Command (Photo Menu)

You click this button or choose this command to change the brightness and contrast of the current photo.

EasyPhoto shows you a dialog box where you can make the adjustments.

Tip If you want to change the brightness and contrast of just part of the photo, select that part first.

Show me how to...

Select part of a photo

Change the brightness and contrast of a photo



Brightness/Contrast Dialog Box

You use this dialog box to change the brightness and contrast of the current photo or selected part of the 
photo.

The Before and After samples give you a good idea of the changes you're making.

Dialog box options
Brightness control Drag the slider left to make the photo darker, right to make it lighter.

Contrast control Drag the slider left for less contrast (less difference between light and dark 
elements), right for more contrast.

Restore Click to start over with the original slider settings.

OK Click to make the changes to the photo. The After sample previews what your 
photo will look like.

Click to look at another part of the preview samples. After you click this button, move the cursor 
over the Before sample. The cursor changes to a hand, which you drag to move the sample in the 
preview boxes.

Click to magnify the preview samples. The cursor changes to a zoom tool. Then click anywhere in
a sample to enlarge the view, centered on where you clicked.

Click to reduce the magnification of the preview samples.
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Adjust Color Command (Photo Menu)

You click this button or choose this command to change the colors of the current photo.

EasyPhoto shows you a dialog box where you can make the adjustments.

Tip If you want to change the colors of just part of the photo, select that part first.
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Adjust Color Dialog Box

You use this dialog box to change the color balance of the current photo or selected part of the photo. 
This is where you come if that sunset turned out too orange or Uncle Jerry's face more green than usual.

The Before and After samples give you a good idea of the changes you're making.

Dialog box options
Color slider bars Drag a slider right for more of that color in the photo, left for less of the color.

Restore Click to start over with the original slider settings.

OK Click to make the changes to the photo. The After sample previews what your 
photo will look like.

Click to look at another part of the preview samples. After you click this button, move the cursor 
over the Before sample. The cursor changes to a hand, which you drag to move the sample in the 
preview boxes.

Click to magnify the preview samples. The cursor changes to a zoom tool. Then click anywhere in
a sample to enlarge the view, centered on where you clicked.

Click to reduce the magnification of the preview samples.
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Remove Scratch Command (Photo Menu)

You click this button or choose this command to remove a "scratch" or a "crease" from the selected part of
the current photo.

EasyPhoto shows you a dialog box where you can touch up the photo.

Tip Before EasyPhoto can remove a scratch, you need to show it where the scratch is. Click the Select
Freehand button and use the mouse to outline the general area of the scratch. You don't have to 
get too precise, just close enough that EasyPhoto can recognize the scratch.
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Remove Scratch Dialog Box

You use this dialog box to remove a "scratch" or a "crease" from the selected part of the current photo. 
This won't do much for that photo the dog chewed, but it does a good job touching up lesser disasters.

The Before and After samples give you a good idea of the changes you're making.

Dialog box options
Width control Drag the slider left if the scratch is narrow, right if it's wide.

Sensitivity control Drag the slider right until the scratch just disappears in the After sample.

Restore Click to start over with the original slider settings.

OK Click to make the changes to the photo. The After sample previews what your 
photo will look like.

Click to look at another part of the preview samples. After you click this button, move the cursor 
over the Before sample. The cursor changes to a hand, which you drag to move the sample in the 
preview boxes.

Click to magnify the preview samples. The cursor changes to a zoom tool. Then click anywhere in
a sample to enlarge the view, centered on where you clicked.

Click to reduce the magnification of the preview samples.
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Remove Red-Eye Command (Photo Menu)

You click this button or choose this command to fix a "red-eye" problem in the selected part of the current 
photo.

EasyPhoto shows you a dialog box where you can touch up the photo.

Tip Before EasyPhoto can fix a red-eye problem, you need to show it generally where the eyes are. 
Click the Select Freehand button and use the mouse to outline the person's face. You don't have to
get too precise, just close enough that EasyPhoto can distinguish between red eyes and red poppy
flowers.
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Remove Red-Eye Dialog Box

You click this button or choose this command to fix a "red-eye" problem in the selected part of the current 
photo. Now you'll no longer have to explain to your mother why all your friends, in the pictures you send 
her, look like aliens.

The Before and After samples give you a good idea of the changes you're making.

Dialog box options
Color Correction Drag the slider right until the eyes just look normal in the After sample.

Restore Click to start over with the original slider settings.

OK Click to make the changes to the photo. The After sample previews what your 
photo will look like.

Click to look at another part of the preview samples. After you click this button, move the cursor 
over the Before sample. The cursor changes to a hand, which you drag to move the sample in the 
preview boxes.

Click to magnify the preview samples. The cursor changes to a zoom tool. Then click anywhere in
a sample to enlarge the view, centered on where you clicked.

Click to reduce the magnification of the preview samples.
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View Menu



Actual Size Command (View Menu)

You choose this command to go back to a normal view of the photo, without any magnification.

When you open a photo in the Photo Workshop, you see it at its actual size. If it's too large to fit in the 
window, use the scroll bars to see other parts of the photo.
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Fit To Window Command (View Menu)

You choose this command to show the whole photo at the largest magnification that will fit in the Photo 
Workshop window.
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Zoom In Command (View Menu)

You choose this command to magnify the view of the current photo. Zoom in to work on small details.

EasyPhoto increases the magnification, keeping the photo centered in the Photo Workshop window.

Note Magnifying a photo this way doesn't change the actual dimensions. If you want to change the size 
of a photo, to fit it into a report, for example, use the Resize command.

Tip You can also click the Zoom In button to magnify the view. In that case, the cursor changes to show
that you can start zooming in. Each click of the zoom cursor increases the magnification, centered 
on the spot you click, up to a magnification of about 8x.
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Zoom In Button

You click this button to magnify the view of the current photo. Zoom in to work on small details.

When you click the zoom button, the cursor changes to show that you can start zooming in. Each click of 
the zoom cursor increases the magnification, centered on the spot you click, up to a magnification of 
about 8x.

Note Magnifying a photo this way doesn't change the actual dimensions. If you want to change the size 
of a photo, to fit it into a report, for example, use the Resize command.

Tip You can also choose the Zoom In command from the View menu to magnify the view. In that case, 
EasyPhoto increases the magnification, keeping the photo centered in the Photo Workshop 
window.
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Zoom Out Command (View Menu)

You choose this command to reduce the magnification of the current photo. Zoom out to see more of a 
large photo or of a photo you've zoomed in on.

EasyPhoto decreases the magnification, keeping the photo centered in the Photo Workshop window.

Note Changing the view of a photo this way doesn't change the actual dimensions. If you want to change
the size of a photo, for example to fit it into a report, use the Resize command.

Tip You can also click the Zoom Out button to reduce the magnification. In that case, the cursor 
changes to show that you can start zooming out. Each click of the zoom cursor decreases the 
magnification, centered on the spot you click, with a minimum magnification of 1/64x.
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Zoom Out Button

You click this button to reduce the magnification of the current photo. Zoom out to see more of a large 
photo or of a photo you've zoomed in on.

When you click the zoom button, the cursor changes to show that you can start zooming out. Each click of
the zoom cursor decreases the magnification, centered on the spot you click, with a minimum 
magnification of 1/64x.

Note Changing the view of a photo this way doesn't change the actual dimensions. If you want to change
the size of a photo, for example to fit it into a report, use the Resize command.

Tip You can also choose the Zoom Out command from the View menu to reduce the magnification. In 
that case, EasyPhoto decreases the magnification, keeping the photo centered in the Photo 
Workshop window.
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Move Button

You click this button to drag and drop the photo, or selected part of the photo, from the Workshop into a 
word-processing document.

The cursor changes to an arrow, showing that you can move the photo. Then, when you click and hold 
down the left mouse button, the cursor changes to the drop cursor, showing that you can drag a copy of 
the photo to your word processor.

Tip You can also drag a copy of the photo or selection to a Photo Gallery. This is an easy way to add 
part of a photo as a new photo to a Gallery.

Tip Your word processor treats a photo just like any other picture or clip art. You can use your word 
processor's tools to move or resize the photo. For the specifics, see the online Help for your word 
processor.
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Select Rectangle Button

You click this button to select a rectangular area of the photo. You select an area to work on just that part 
of the photo. For example, you can select a too-bright sky--everything above the horizon line--and tone it 
down a little.

After you click this button and move the mouse over the photo, the cursor changes to a "cross-hairs", 
showing that you can drag the mouse to select an area.

While the Select Rectangle button is selected, you can redraw new selections. To stop selecting, press 
the Esc key, click outside the photo, or click the Move or Select Freehand button.

Tip Once you select an area, you can make it larger or smaller. To resize a selection, drag the border.

Tip You can draw multiple selections or add to the first selection. After selecting the first area, hold 
down the Shift key and draw another selection. Or, to deselect part of the selection, hold down the 
Alt key and drag a rectangle around the part you want to subtract from the selected area.
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Select Freehand Button

You click this button to select an irregularly shaped area of the photo. You select an area to work on just 
that part of the photo. For example, you can select a shaded face and lighten it.

After you click this button and move the mouse over the photo, the cursor changes to a "lasso", showing 
that you can drag the mouse to select an area.

If you select door number two, you might win a refrigerator.

Tip While the Select Freehand button is selected, you can redraw new selections. To stop selecting, 
press the Esc key, click outside the photo, or click the Move or Select Rectangle button.

Tip You can draw multiple selections or add to the first selection. After selecting the first area, hold 
down the Shift key and draw another selection. Or, to deselect part of the selection, hold down the 
Alt key and drag around the part you want to subtract from the selected area.
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